SAP Test Acceleration and Optimization
How-to guide

August 2011
7.1.1 Customizing Change - PO Number has become mandatory in VA01 transaction ................................................................. 104
7.1.2 Custom code change – New input field is introduced in Custom VA01 transaction ................................................................. 109

7.2 Repair without BPCA Integration .................................................................................................................. 111
7.2.1 Customizing Change - PO Number has become mandatory in VA01 transaction ................................................................. 111
7.2.2 Custom code change – New input field is introduced in Custom VA01 transaction ................................................................. 116

8 FAQ ........................................................................................................................................................................ 120
8.1 TBOM Creation .................................................................................................................................................. 120
8.2 Miscellaneous .................................................................................................................................................. 121

9 Appendix ............................................................................................................................................................ 121
9.1 Manual Test Case Composition ....................................................................................................................... 121
9.2 Enable Scripting ................................................................................................................................................ 122
9.3 SAP Logon entries for TBOM Creation .............................................................................................................. 123
9.4 Citrix and SAP TAO ........................................................................................................................................... 125
9.5 SAP TAO and ALM 11 (SAP Quality Center 11) ............................................................................................. 126
9.6 Component for Support Messages .................................................................................................................... 127
9.7 Relevant Notes .................................................................................................................................................. 127
9.8 For More Information .................................................................................................................................... 127
1 Introduction

The SAP Test Acceleration and Optimization application supports customers in automating their business process tests by automatically generating draft test cases and test components. Its tight integration with SAP Solution Manager helps in identifying the impacted test cases and components when there are changes in the landscape. The SAP Test Acceleration and Optimization application creates modular test cases, which are easy to maintain, when the test cases are damaged due to functional changes.

In the face of continuous, accelerated change in the business environment, there is an increasing demand for innovation and an increased frequency of change in business applications. Any change to your solution landscape requires testing to ensure software quality and minimize business and IT risk. But since so many testing tasks require manual effort, quality assurance teams find themselves pressed for time. To stay on schedule, teams must often either delay the release or skip critical tests. Even if testing activities are automated using traditional tools, it becomes difficult to maintain these scripts. This leads to higher cost or risky testing process.

In order to effectively address the above mentioned challenge, SAP offers the SAP Test Acceleration and Optimization application, which helps you in quick creation of automated test cases using reusable components.

The SAP Test Acceleration and Optimization application supports customers in automating their business process tests by automatically generating draft test cases and test components for SAP GUI–based transactions. Using this application in combination with the SAP Quality Center application by HP, you can modify, compose and execute automated business process tests in SAP software development and test systems. The SAP Test Acceleration and Optimization application also provides a lot of reusable library components, which could be used for test composition.

SAP Test Acceleration and Optimization helps you change the testing paradigm from manual testing to testing by composition, thereby reducing the costs and risks for testing SAP solutions. The benefits include reduced effort for maintaining automated business process tests, reduced risk due to better testing coverage, increased capacity to absorb and manage change, and tight integration with the SAP Solution Manager. The tool is tightly integrated with SAP Solution Manager’s Business Process Change Analyzer functionality to report impacted test cases and components due to changes in landscape.

SAP Test Acceleration and Optimization helps in quick creation and maintenance of test cases, which leads to higher test coverage, at a very less cost compared to manual testing and shorter testing cycles. The efficiency you gain can reduce costs, increase speed, and more importantly, help minimize the risk of outages and other problems caused by poor testing.
Return on investment for the SAP Test Acceleration and Optimization application is much faster than traditional automation, as the test case generated by it are easier to maintain because of their modular nature. If compared with Manual Testing, the crucial benefit is SAP Test Acceleration and Optimization automated scripts require very less effort to execute, and so is the savings in the resource utilization.
2 Scope of document

This document is based on SAP TAO 2.0 SP6. Any reference or description of older releases is explicitly mentioned and described as is.
3 Setup

3.1 SAP TAO 2.0 Installation files

SAP TAO 2.0 requires following installations:

1. ST-DAO: ST-DAO 200 SP6 need to be installed on SAP Solution Manager 7.0 SP25 and above.
2. ST-PI: Latest Solution Manager Tool Plug-in (ST-PI) need to be installed on the managed system, e.g. ECC 6.0
3. SAP TAO Front End: this need to be installed on a desktop/laptop with Windows 7, Windows Vista or Windows XP 32 bit Operating system.

Please note that the complete compatibility matrix of SAP TAO versions is also documented in SMP as described in section described in section Compatibility Matrix between SAP Solution Manager, SAP Quality Center by HP, Adapter and SAP TAO.

Steps to download latest SAP TAO 2.0 Service Packs are:

1. Go to URL: http://service.sap.com/swdc -> Support Packages and Patches -> Application by Index and select the letter “T”.

Figure: Access SAP TAO Installation Files
2. Select SAP TAO.

3. Select SAP TAO 2.0.

4. Click on “Comprised Software Component Versions”.

5. To download ST-TAO click on ST-TAO 200.
6. To download the latest ST-PI which has SAP TAO Agent, click on the “ST-PI 2008_1_XXX”, depending on the version of the managed system where you want to install the ST-PI.
7. To download SAP TAO Front end click on “SAP TEST ACCEL. AND OPT.2 .0” -> Win32
8. Download the latest front end.
In the above figure, the latest service pack is highlighted.

### 3.2 Setup of SAP TAO

If you would like to upgrade from a previous SAP TAO installation, please read the SAP TAO Upgrade chapter.

Read the SAP Note: [1404715](#) for installing latest version of SAP TAO.

The license for SAP TAO could be retrieved by connecting to SAP Solution Manager SP 20 and above. The connection can be done in the Configuration-> License Tab.

![License Configuration](image)

*Figure: License Configuration*
3.2.1 Settings for SAP Quality Center to work with SAP TAO

The SAP TAO relies on some scripts to initialize its execution context when executing a test. The section hereafter describes the settings required to enable SAP TAO Runtime Libraries.

Settings in SAP Quality Center

1. Upload the file (i.e. “C:SAPTAORTL\CBASE\CBASE_Init.vbs.txt”) to your SAP Quality Center.

2. SAP Test Acceleration and Optimization 2.0 require the following parameters to be set accordingly.
   - DISABLE_EXTENDED_STORAGE=N
   - BACKWARD_SUPPORT_ALL_DOMAINS_PROJECTS=Y

   Restart the SAP Quality Center server if the parameters have been properly set.
3.2.2 Settings for QuickTest Professional to work with SAP TAO

Settings in QTP

1. Provide connection details to SAP Quality Center by going Quick Test Professional -> File -> Quality Center Connection.

2. QTP Options -> Run Configuration
   a. Open QuickTest Professional
   b. Click on Options
   c. Click on Run
   d. Enable the check box to allow other HP Products to Run, and also show result at the end of the execution.
3.2.3 Settings for SAP GUI

In the SAP GUI, the front end scripting should be enabled by going to SAP Logon -> Options.

It is also important all the notifications in the user settings of the scripting configuration is disabled to avoid pop-ups whenever a script attaches with SAP GUI or opens a connection.
3.2.4 Application Area Creation in QuickTest Professional

SAP TAO needs to load some additional “add-ins” while a Test. The list of add-ins that is required to be loaded needs to be declared by creating an Application Area. The Application Area dedicated to SAP TAO must be created in QTP.

Application Area Creation

Create an application area “_SAP_Doc” if it does not already exist. Follow following steps to create a new application area.

- Open QuickTest Professional
- Connect to the SAP Quality Center project through QuickTest Professional
- Select New -> Application Area
- Make sure that the SAP and Web add-ins are selected
- Make sure that the Function Libraries section is empty; no library should be declared.
- Save the application area with the name “_SAP_Doc”
3.2.5 Exporting Default Components to Quality Center

Library components are exported to Quality Center and it is then used by Process Flow Analysis for functionality of SAP TAO to weave test cases

Caution
If you are updating a project which already has SAP TAO library components, it’s recommended to back-up the project before the update. This activity is recommended as update of library components overwrites already existing ones.

SAP TAO 2.0 version generates automated tests that are using a new set of library components. These components should be uploaded to Business Process Testing (BPT) module of SAP Quality Center. The SAP TAO Import/Export functionality can be used to export the Default Components to your SAP Quality Center project.

Since SAP TAO 2.0 SP6, the upload of Default Components is simplified. The components can be easily uploaded by clicking on “Upload Default Components” button which is present in Import/Export module of SAP Quality Center.

Procedure for releases earlier than TAO 2.0 SP6
Please proceed as described below:

- Start SAP TAO 2.0.
- Click on the Import/Export module.
- On the left side, you can see the default components located on your local hard disk drive. Make sure the right folder is selected and export it to SAP Quality Center. Choose the “COMPONENTS Default” folder which is present inside SAP TAO installation folder. By default, it is located at “C:\Program Files\SAP\SAP TAO\COMPONENTS_Default”.

- On the right hand side, you would see existing SAP Quality Center components hierarchy.
- Select the SAP Front End and SAP R3 nodes like shown in the screenshot below.

© 2011 SAP AG
Then click the Export button to start the operation.

**Remark**

The recommended component location in Business Process Testing module of SAP Quality Center is:

- Components
  - SAP Front End
  - SAP R3

Putting the components at a different location is possible but **not recommended**.
3.2.6 Roles on SAP Solution Manager and Managed Systems

The role required by the user which is connected to SAP Solution Manager from SAP TAO is \texttt{SAP\_SM\_TAO\_RFC} and the role required for the user connected to the managed system from SAP TAO is \texttt{SAP\_TAO\_AGENT\_RFC}. Please note additional roles are required for TBOM creation.

3.2.7 ST-PI on the managed system

The ST-PI recommended on the managed system can be got from Compatibility Matrix.

In case if you have ST-PI 2008 XXXX SP 03, and you need to upgrade to latest agent, implement note:

\textbf{SAP Note: 1498732 - Improve TAO inspection for text fields with input help}

3.2.8 Prerequisites to TBOM creation from SAP TAO

3.2.8.1 User-IDs and Authorizations

In order to re-use SAP TAO based test cases to create TBOMs, several authorizations are required on SAP Solution Manager and managed systems.

Possible User ID combinations:

<table>
<thead>
<tr>
<th>Case</th>
<th>User in Solution Manager</th>
<th>User in Managed System</th>
<th>User passed to Launch and Login component of a test case (present in data spreadsheet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In SAP TAO configuration: “User Id A”</td>
<td>Configured in SAP TAO connection: “User Id A”</td>
<td>Test execution with “User Id A”</td>
</tr>
<tr>
<td>2</td>
<td>In SAP TAO configuration: “User Id A”</td>
<td>“User Id A” exists (but it is not used for execution)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configured in SAP TAO connection: “User Id B”</td>
<td>Test execution with “User Id B”</td>
</tr>
</tbody>
</table>

The following authorizations are needed depending on the above mentioned situation

\textbf{Case 1:}

\textbf{User A needs the following authorizations on SAP Solution Manager}

1. Required Role in order to display Business Blueprint Structure of a solution manager project:
   \texttt{SAP\_SOL\_PROJ\_ADMIN\_DIS}
2. Required Role in order to create / modify TBOMs
   \texttt{SAP\_SM\_BPCA\_TBOM\_ALL}
3. Required Role in order to start/ stop trace recording on the managed SAP system, and to subsequently collect the trace information for TBOM creation:
   \texttt{SAP\_S\_RFCACL}
User A needs the following authorizations on the managed SAP system at least

4. Required Role in order to be able to start/stop trace recording on the managed SAP system, and to subsequently collect the trace information for TBOM creation:
   SAP_S_RFCACL

5. User A should be able to process business transaction on the managed system

Case 2:

User A needs the following authorizations on SAP Solution Manager

1. Required Role in order to display Business Blueprint Structure of a solution manager project:
   SAP_SOL_PROJ_ADMIN_DIS

2. Required Role in order to create/modify TBOMs
   SAP_SM_BPCA_TBOM_ALL

3. Required Role in order to start/stop trace recording on the managed SAP system, and to subsequently collect the trace information for TBOM creation:
   SAP_S_RFCACL

User A needs the following authorizations on the managed SAP system at least

4. Required Role in order to be able to start/stop trace recording on the managed SAP system, and to subsequently collect the trace information for TBOM creation:
   SAP_S_RFCACL

User B needs to have the following authorization on the managed system at least

5. User B should be able to process business transaction on the managed system

Caution

Authorizations for executing the business scenario(s)

1. In case 1: User A needs to be able to process the business scenario(s)

2. In case 2: User B needs to process the business scenario(s).
   (Note: User B does not need to have RFC authorizations)

### 3.2.8.2 Existence of Trusted RFC connection

A trusted RFC connection must be available in both directions between the SAP Solution Manager and the Managed Systems for TBOM Creation. This helps in switching on/off the traces which are required for this purpose. As described in the following chapters, this is an important step. Please note additional steps are also required for TBOM creation.

In order to verify the existence of an appropriate trusted RFC connection, process transaction SM59. You will be shown a similar screen as the following one:
In the logon tab, the user configured should match with the user provided in SAP TAO for Solution Manager connection. Normally it would be set as current user, so any user given in SAP TAO for SAP Solution Manager connection is valid.

Subsequently, execute the “Remote Logon” in order to log on to the corresponding Managed System. From Managed system, also try to logon to SAP Solution Manager using this trusted RFC connection. Please note in the managed system both Back and Trusted connection should be present:

```
- SM_SYSCLNT209_BACK
- SM_SYSCLNT209_TRUSTED
```

### 3.2.8.3 Message Server Host provision via SAP logon entry

The entry for the Managed System in SAP Logon must appropriately provide the Message Server Host as this is needed in order to determine the actual Managed System. Please find an exemplary screen-shot showing 4 valid entries and 1 invalid entry (last line outlined in blue):

<table>
<thead>
<tr>
<th>Name</th>
<th>System Description</th>
<th>SID</th>
<th>GroupServer</th>
<th>Message Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 [AppSrv1]</td>
<td>SAP GRP VIRSANH 490_620</td>
<td>DB2</td>
<td>vmw2962.wdf.sap.corp</td>
<td>02</td>
</tr>
<tr>
<td>DB2 [AppSrv2]</td>
<td>SAP GRP VIRSANH 490_620</td>
<td>DB2</td>
<td>vmw2962</td>
<td>02</td>
</tr>
<tr>
<td>DB2 [MsgSrv1]</td>
<td>SAP GRP VIRSANH 490_620</td>
<td>DB2</td>
<td>SPACE</td>
<td>02</td>
</tr>
<tr>
<td>DB2 [MsgSrv2]</td>
<td>SAP GRP VIRSANH 490_620</td>
<td>DB2</td>
<td>SPACE</td>
<td>02</td>
</tr>
<tr>
<td>DB2 [NOT VALID - IP]</td>
<td>SAP GRP VIRSANH 490_620</td>
<td>DB2</td>
<td>10.0.99.17</td>
<td>02</td>
</tr>
</tbody>
</table>

In fact, the message server host together with the short SID helps composing a unique key for determining the target ABAP system. SAP TAO will first use “Message Server” property, but if it is not
provided, then it would try to use the “Group/Server” entry. The fall back to “Group/Server” will work only if the Application server and message are on the same host.

### 3.2.8.4 TBOM enabling in SAP TAO Client

The TBOM creation functionality has to be explicitly enabled from Configuration-> Run and Report tab. This way user can switch off the TBOM creation functionality when it’s not required to improve SAP TAO performance.

![Configuration page](image)

### 3.3 SAP TAO Upgrade

#### 3.3.1 Overview

The following chapters assume that you would like to upgrade SAP TAO to the latest version or at least to the SAP TAO 2.0 SP2, where improved SAP TAO runtime library and default components were delivered. These new library components (by default) are located in “Components/SAP Front End” folder of SAP Quality Center’s Business Process Testing (BPT) module.

The older sets of default library components are still delivered and they can be used by Test Engineers to compose test cases using manual (drag and drop) approach in the Test Plan module of SAP Quality Center. They are provided only for backward compatibility purposes and they are located in the “Components/SAP R3” folder of SAP Quality Center’s Business Process Testing (BPT) module.

The usage of old library component is not recommended for all the test cases created using SAP TAO 2.0 SP2 and above.

The SAP TAO upgrade can be easier when the existing Tests, that are stored into SAP Quality Center by HP, are built on top of unchanged SAP TAO Runtime Library and Default Components (version 1.0.10 or higher). However, the upgrade becomes complicated as soon as the Runtime Library or Default Components have been modified to address customer-specific requirements. It is also difficult if your existing SAP TAO version is lower than 1.0.10 (TAO 1.0 SP10).

Following are different kinds of customer specific changes which are possible:
Some Visual Basic Scripting code has been written in the **CBASE_Custom_Wrappers.vbs** file. This is the recommended extension mechanism and this document will explain you how to manage this code in the upgrade process of SAP TAO.

Some additional Visual Basic Scripting files have been developed and declared in the SAP TAO **“CBASE.Config”** file. This is supported and this document will explain you how to manage this code in the upgrade process of SAP TAO.

Some changes have been performed in the SAP delivered files of SAP TAO Runtime Library (RTL) Visual Basic Scripts. It is not recommended to change any SAP delivered files and requires hiring of consultants (experts) for upgrading SAP TAO. **This case is not covered by this document.**

Some updates have been done in the SAP TAO Default Components Visual Basic scripts. It is not recommended to change any SAP delivered components and if they were changed, then consultants (experts) need to be hired to support the upgrade process. **This case is not covered by this document.**

The following are the currently known upgrade paths. The customers need to identify the upgrade path which suits their situation:

<table>
<thead>
<tr>
<th>Existing SAP TAO Version</th>
<th>Future SAP TAO Version</th>
<th>Upgrade Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0 or Higher</td>
<td>Latest SAP TAO SP (at least SAP TAO 2.0 SP2)</td>
<td>1</td>
</tr>
<tr>
<td>1.0 SP10 and 1.0 SP11</td>
<td>Latest SAP TAO SP (at least SAP TAO 2.0 SP2)</td>
<td>2</td>
</tr>
<tr>
<td>Lower than 1.0 SP10</td>
<td>Latest SAP TAO SP (at least SAP TAO 2.0 SP2)</td>
<td>3</td>
</tr>
</tbody>
</table>

The following steps explain each upgrade path in detail.

### 3.3.2 Upgrade Prerequisites

You need to execute the following steps before starting actual upgrade process:

<table>
<thead>
<tr>
<th>No.</th>
<th>Step Description</th>
<th>Steps Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Backup your custom libraries (if any)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Check the Compatibility Matrix</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Verify the Test Landscape</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Backup the SAP Quality Center projects that contain the SAP TAO based tests using the backup facility provided by Hewlett Packard.</td>
<td></td>
</tr>
</tbody>
</table>

### 3.3.3 Upgrade Path #1 - Upgrading from Version 2.0 or Higher

You need to execute the subsequent steps:

<table>
<thead>
<tr>
<th>No.</th>
<th>Step Description</th>
<th>Steps Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Export Default Components to Quality Center</td>
<td></td>
</tr>
</tbody>
</table>
2 Reconsolidate the existing Tests
3 Restore Custom Libraries
4 Check the CBASE consistency
5 Run the **SAP TAO Self Checks** to make sure the SAP TAO setup is consistent.
6 Create a new Test using the PFA and verify its execution.
7 **Verify the execution of former Tests** created with the previous SAP TAO version.

### 3.3.4 Upgrade Path #2– Upgrading from Version 1.0.10.0 or Higher

You need to process these steps.

<table>
<thead>
<tr>
<th>No.</th>
<th>Step Description</th>
<th>Steps Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Export Default Components to Quality Center</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Reconsolidate the existing Tests</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Restore Custom Libraries (if any)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Check the CBASE consistency</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Run the <strong>SAP TAO Self Checks</strong> to make sure the SAP TAO setup is consistent.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Create a new Test using the PFA and verify its execution.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td><strong>Verify the execution of former Tests</strong> created with the previous SAP TAO version.</td>
<td></td>
</tr>
</tbody>
</table>

### 3.3.5 Upgrade Path #3 – Upgrading from Versions Lower than 1.0.10.*

You need to perform the steps below.

<table>
<thead>
<tr>
<th>No.</th>
<th>Step Description</th>
<th>Steps Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Move the current set of Default Components to a different location.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Export Default Components to Quality Center</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Reconsolidate the existing Tests</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Override the CBASE_SAP_INIT.vbs.txt file and upload it to HP Quality Center.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Enable obsolete CBASE libraries</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Restore custom libraries (if any)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Check the CBASE consistency</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Run the <strong>SAP TAO Self Checks</strong> to make sure the SAP TAO setup is consistent.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Create a new Test using the PFA and verify its execution.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td><strong>Verify the execution of former Tests</strong> created with the previous SAP TAO version.</td>
<td></td>
</tr>
</tbody>
</table>
3.4 Upgrade Prerequisites

3.4.1 Backup of the Existing Test Landscape

SAP recommends to backup current test landscape before the actual upgrade is started. Following steps explain the activities for the backup:

- Back up SAP Quality Center Projects – please refer to official HP documentation on how to perform that step.
- Back up the SAP TAO Runtime Library present in the environment variable %FF_ROOT_PATH%.
  - CBASE folder located at %FF_ROOT_PATH%
  - The Test Components located in the folder “COMPONENTS_Default” present in the path %FF_ROOT_PATH%
  - The test data table files (Microsoft Excel files).

3.4.2 Check the Compatibility Matrix

Please make sure that the SAP TAO version running client-side is compatible with the Solution Manager System and with the Systems that you want to test. The “SAP TAO Compatibility Matrix” is available on the SAP Service Market Place. For more information please the chapter “3.6 Compatibility Matrix between SAP Solution Manager, SAP Quality Center by HP, Adapter and SAP TAO”.

3.4.3 Verification of the Test Landscape

To be on the safe side, it is important to understand that all SAP TAO Clients should use the same SAP TAO versions and share a single CBASE Library folder. The selection of the folder to put the libraries is made by a wizard that is automatically launched when SAP TAO application is started for the first time.

![SAP TAO Wizard](image)

Figure: SAP TAO Wizard

If you wish to execute this wizard again, perform the following:

- Start SAP TAO
- Click on the configuration link at the top
- Select the RTL tab
• Click on the “Open Wizard” button on the right hand side

When the CBASE is shared, the upgrade steps described in this document should be done only once and on a single SAP TAO Client computer. Once the upgrade is complete, all other client computers should work properly as soon as they connect to the same SAP Quality Center Project and CBASE folder.

The figure below shows the typical SAP TAO Landscape. Note that setup and upgrade steps have to be performed only once and that the other computers running SAP TAO should not be used during those steps.
3.5 Upgrade Step Descriptions

3.5.1 Exporting Default Components to Quality Center

If not already done, it is highly recommended to make a backup of the Quality Center project before proceeding.

Exporting the Default Components is a setup step that is to be done in any case. The regular way to perform this operation is described in the chapter: **Exporting Default Components to Quality Center** on page 14.

When upgrading to a new version of SAP TAO, the export of the new set of Default Components must override the previous Default Components that are existing in SAP Quality Center by HP.
Please make sure that the existing folder hierarchy in the BPT Module matches the expected one. The recommended component location is:

- Components
  - SAP Front End
  - SAP R3

If the current component hierarchy is different please make sure to move the former Default Components to the recommended location (SAP R3 folder in the BPT module). Moving components to a different location has no impact to existing Tests because components are not referenced using the component path and name; an internal ID is used instead.
3.5.2 Reconsolidate Existing Tests

SAP TAO relies on the concept of Consolidation to improve the performance of the test execution. The consolidation of tests creates a Consolidated Component by merging together the scripts of all Components that the automated test contains.

Since library components are changed, all the existing test cases must be consolidated again so that they could make use of the improved default component and SAP TAO runtime library.

Before proceeding with consolidation, SAP TAO should point to right location where the consolidated components are created. The setting for this folder can be found in the TAO configuration (Consolidate tab).

![Location of Consolidated Components](image)

The consolidated components should be overwritten by the new ones. Please make sure the Overwrite consolidated components in SAP TAO configuration option is checked. This option is located in the Consolidation configuration tab.

![Component Creation](image)

To reconsolidate all the test cases, execute the following steps:

- In SAP TAO, navigate to the Consolidate module.
- In the “All Tests” tab, select the tests to consolidate.
- Click the “Add to consolidation list” button. The consolidation list tab appears.
- Click the “Consolidate” button.
- This action takes some time. Please be patient.

3.5.3 Moving the Former Default Components to a Different Location

This step only applies to Upgrade Path #3 – meaning when upgrading from version lower than SAP TAO 1.0 SP10. This specific step is necessary because the existing components and tests that are stored in the SAP Quality Center project are not being compatible with the new SAP TAO Runtime Library. In such situation SAP recommends to maintain two sets of Default Components in your Quality Center project by moving the former version of components into a dedicated folder.

For instance, all Default Components of the SAP TAO 1.0 SP3 could be moved from their current location to a new QC folder at:

```
Components/SAP TAO 1.0 SP3/SAP R3
```

Moving the components to a different location does not impact existing tests because the relationship between Tests and Test Components relies on some internal ID.

The new Default Components can now be exported to QC and put at the regular location which is:
3.5.4 Override the CBASE_SAP_INIT.vbs.txt file

This step only applies to Upgrade Path #3 – meaning when upgrading from version lower than SAP TAO 1.0 SP10. This manual step is required because Default Components of SAP TAO 1.0 were initialized using a script which is not delivered anymore.

SAP TAO components were initialized using the following statement:

```
ExecuteFile "[QualityCenter] Subject\BPT Resources\Libraries\CBASE_SAP_Init.vbs.txt"
```

The new components are using the following statement:

```
ExecuteFile "[QualityCenter] Subject\BPT Resources\Libraries\CBASE_Init.vbs.txt"
```

The proposal here is to avoid changing the old components. It is instead possible to change the CBASE_SAP_Init.vbs.txt file into SAP Quality Center and make sure it initializes the SAP TAO 2.0 CBASE in a proper way. In other words, we need to copy the content of the CBASE_Init.vbs.txt file to the CBASE_SAP_Init.vbs.txt file and upload it again to HP Quality Center:

- On your local host, go to the start menu and run.
  - Enter `%FF_ROOT_PATH%` in the run window field and validate. An explorer window opens, showing the CBASE library folder.
  - Look for the **CBASE_Init.vbs.txt** file. Duplicate it to **CBASE_SAP_Init.vbs.txt**.
  - Now, in the Quality Center UI, navigate to the **Test Plan** area.
  - Select the Subject/BPT Resources/Libraries node
  - Click on the Attachments tab
  - Delete the **CBASE_SAP_Init.vbs.txt** if it exists.
  - Click on the Upload button and choose the **CBASE_SAP_Init.vbs.txt**

Note that after this change the SAP TAO 1.0 CBASE and its CBASE_SAP_47_Init.vbs script will not be used anymore.
The screenshot below shows the content of the Subject/BPT Resources/Libraries folder before uploading the `CBASE_SAP_Init.vbs.txt` file.

**Figure: CBASE_Init.vbs.txt in HP Quality Center**
Standard **CBASE_Init** Script (SAP TAO 2.0)

The **CBASE_Init.vbs.txt** script is the one below:

```vbscript
If Not CBASE_BOOTSTRAP Then
    Set Shell = CreateObject("WScript.Shell")
    Set WshEnv = Shell.Environment("USER")
    Path = WshEnv("FF_ROOT_PATH")
    '-----------------------------------------------------
    ' Loads the CBASE_Bootstrap library if the lib is not
    ' already declared in the _SAP_Doc_ Application Area
    '-----------------------------------------------------
    ExecuteFile Path & "CBASE\CBASE_Bootstrap.vbs"
End If

If CBASE_BOOTSTRAP Then
    If CBASE_BOOTSTRAP_ONLY THEN
        ' Nothing to do - the InitializeContext Component still
        ' needs to specify the context!
        '----------------------------------------------------------
    Else
        '----------------------------------------------------------
        ' Initialize the TAO Execution Context based on parameters
        ' specified by the InitializeContext Component.
        '----------------------------------------------------------
        TaoExecutionContext().InitializeContext()
    End If
Else
    '----------------------------------------------------------
    ' Initialization failed - CBASE_Bootstrap is inconsistent
    '----------------------------------------------------------
    MsgBox "The TAO Execution Context could not be initialized. " _
        & vbCrLf & vbCrLf _
        & "The CBASE\CBASE_Bootstrap.vbs library is not consistent." _
        & vbCrLf _
        & "Please run the TAO Selfchecks to get additional details." , _
        vbOKOnly, "SAP TAO"
End If
```
3.5.5 Restore the Custom Libraries

These steps are applicable to all upgrade situations if SAP TAO Runtime Library has been modified to address some customer-specific requirements.

The description hereafter assumes that the new CBASE library is already in place. In other words, the new libraries that SAP TAO delivers should be located at the shared location as defined by the FF_ROOT_PATH environment variable at: %FF_ROOT_PATH%\CBASE

The FF_ROOT_PATH environment variable is defined when SAP TAO 2.0 is started for the first time. A SAP TAO wizard lets the user selects the shared location where the CBASE libraries are to be installed. Please make sure this operation is done only once and that all Testers are sharing the same CBASE folder.

See Verification of the Test Landscape for more details.

Note:

There are different kinds of modifications to observe:

- Some Visual Basic code has been written in the \_CBASE\_Custom\_Wrappers.vbs file. This is the recommended extension mechanism. See below for further details.
- Some additional Visual Basic files have been developed and declared in the SAP TAO CBASE.Config file. This is supported (see below).
- Some changes have been performed in the SAP TAO Runtime Library (RTL) Visual Basic Scripts. This is prohibited and requires a consultants facilitate the upgrade. This situation is not covered by the document.
- Some updates have been done in the SAP TAO Default Component Visual Basic scripts. This is prohibited and requires a consultants facilitate the upgrade. This situation is not covered by the document.

The SAP Recommendation regarding custom code is to put it in the \_CBASE\_Custom\_Wrappers.vbs file or to isolate it in customer-specific libraries.

Make sure to first check whether your CBASE backup contains a custom version of the \_CBASE\_Custom\_Wrappers.vbs file or not. You need to restore this custom wrappers file to new CBASE library.

Then, verify whether your CBASE backup contains additional custom libraries (additional files containing custom VBS scripts). The SAP Recommendation is to put them in a dedicated sub folder; for instance:

%FF_ROOT_PATH%\CBASE\CustomLibraries

Example for 2 files:

%FF_ROOT_PATH%\CBASE\CustomLibraries\MyCustomLibrary.vbs
%FF_ROOT_PATH%\CBASE\CustomLibraries\MyOtherCustomLibrary.vbs

It is necessary to refer to these files in the CBASE configuration file at:

%FF_ROOT_PATH%\CBASE\CBASE.Config
For example:

```vbs
<FILES>
<!-- CBASE Libraries - The libraries described below are loaded at startup by CBASE\CBASE_Bootstrap.vbs -->
<FILE>CBASE_Foundation_DT.vbs</FILE>
<FILE>CBASE_Foundation_Reports.vbs</FILE>
<FILE>CBASE_FoundationUtilities.vbs</FILE>

<FILE>CBASE_SAP_47_Wrappers.vbs</FILE>
<FILE>CBASE_SAP_47_Lib.vbs</FILE>
<FILE>CBASE_SAP_47_Gets.vbs</FILE>
<FILE>CBASE_SAP_47_Verifications.vbs</FILE>
<FILE>CBASE_TAO_47_Wrappers.vbs</FILE>

<!-- Obsolete libraries are not loaded by default - Uncomment the next lines to load them -->
<!--
<FILE>ObsoleteLibraries\CBASE_Foundation_Global.vbs</FILE>
<FILE>ObsoleteLibraries\CBASE_Foundation_Wrappers.vbs</FILE>
<FILE>ObsoleteLibraries\CBASE_WEB_Gets.vbs</FILE>
<FILE>ObsoleteLibraries\CBASEObsolete.vbs</FILE>
-->

<!-- Custom Libraries -->
<FILE>CustomLibraries\MyCustomLibrary.vbs</FILE>
<FILE>CustomLibraries\MyOtherCustomLibrary.vbs</FILE>

<!-- Libraries that can be changed by customer -->
<FILE>CBASE_Custom_Wrappers.vbs</FILE>

<!-- GS_Kernel - Core Feature to handle SAP Gui Session and retrieve GuiScripting Objects -->
<FILE>GS_Kernel.vbs</FILE>
<FILE>GS_Common.vbs</FILE>
<FILE>GSUtilities.vbs</FILE>
<FILE>GSDataSource.vbs</FILE>

<!-- CBASE_HotFixes.vbs is delivered empty by official SAP TAO Releases -->
<FILE>HotFixes\CBASE_HotFixes.vbs</FILE>
</FILES>
```

In addition, it is necessary to execute the old tests to make sure they all pass. If some don’t, check if some custom code is missing.
3.5.6 Enable Obsolete CBASE Libraries

This upgrade step is only relevant when some of the existing tests have been created using SAP TAO versions lower than 1.0 SP10 or if custom components have been developed on customer side.

SAP TAO 2.0 delivers some Obsolete Libraries only for backward-compatibility purposes. Those libraries are, by default, excluded from the CBASE configuration but they are still deployed at:

```
%FF_ROOT_PATH%\CBASE\ObsoleteLibraries
```

This folder contains (at least):
- `CBASE_Foundation_Global.vbs`
- `CBASE_Foundation_Wrappers.vbs`
- `CBASE_Obsolete.vbs`
- `CBASE_WEB_Gets.vbs` (pay attention that SAP TAO does not support web testing)

When existing tests depend on those obsolete libraries, it is then necessary to change the CBASE configuration file to make sure that they are loaded again. The configuration file is located at:

```
%FF_ROOT_PATH%\CBASE\CBASE.Config
```

This XML file contains a section declaring the list of libraries that need to be loaded by default.

The regular content of that section is the one below:

```xml
<FILES>
  <!-- CBASE Libraries - The libraries described below are loaded at startup by CBASE\CBASE_Bootstrap.vbs -->
  <FILE>CBASE_Foundation_DT.vbs</FILE>
  <FILE>CBASE_Foundation_Reports.vbs</FILE>
  <FILE>CBASE_Foundation_Utilities.vbs</FILE>
  <FILE>CBASE_SAP_47_Wrappers.vbs</FILE>
  <FILE>CBASE_SAP_47_Lib.vbs</FILE>
  <FILE>CBASE_SAP_47_Gets.vbs</FILE>
  <FILE>CBASE_SAP_47_Verifications.vbs</FILE>
  <FILE>CBASE_TAO_47_Wrappers.vbs</FILE>

  <!-- Obsolete libraries are not loaded by default - Uncomment the next lines to load them -->
  <FILE>ObsoleteLibraries\CBASE_Foundation_Global.vbs</FILE>
  <FILE>ObsoleteLibraries\CBASE_Foundation_Wrappers.vbs</FILE>
  <FILE>ObsoleteLibraries\CBASE_WEB_Gets.vbs</FILE>
  <FILE>ObsoleteLibraries\CBASE_Obsolete.vbs</FILE>

  <!-- Libraries that can be changed by customer -->
  <FILE>CBASE_Custom_Wrappers.vbs</FILE>

  <!-- GS_Kernel - Core Feature to handle SAP Gui Session and retrieve GuiScripting Objects -->
  <FILE>GS_Kernel.vbs</FILE>
  <FILE>GS_Common.vbs</FILE>
  <FILE>GS_Utilities.vbs</FILE>
  <FILE>GS_DataSource.vbs</FILE>

  <!-- CBASE_HotFixes.vbs is delivered empty by official SAP TAO Releases -->
  <FILE>HotFixes\CBASE_HotFixes.vbs</FILE>
</FILES>
```

As shown here the obsolete libraries are commented out by default. SAP therefore suggests adding the ones that are relevant for running the existing Tests.
For instance:

```xml
<FILES>
<!-- CBASE Libraries - The libraries described below are loaded at startup by CBASE\CBASE_Bootstrap.vbs -->
<FILE>CBASE_Foundation_DT.vbs</FILE>
<FILE>CBASE_Foundation_Reports.vbs</FILE>
<FILE>CBASE_Foundation_Utilityvbs</FILE>
<FILE>CBASE_SAP_47_Wrappers.vbs</FILE>
<FILE>CBASE_SAP_47_Lib.vbs</FILE>
<FILE>CBASE_SAP_47_Gets.vbs</FILE>
<FILE>CBASE_SAP_47_Verifications.vbs</FILE>
<FILE>CBASE_TAO_47_Wrappers.vbs</FILE>

<!-- Obsolete libraries are not loaded by default --
Uncomment the next lines to load them -->
<FILE>ObsoleteLibraries\CBASE_Foundation_Global.vbs</FILE>
<FILE>ObsoleteLibraries\CBASE_Foundation_Wrappers.vbs</FILE>
<FILE>ObsoleteLibraries\CBASE_WEB_Gets.vbs</FILE>
<FILE>ObsoleteLibraries\CBASE_Obsolete.vbs</FILE>

<!-- Libraries that can be changed by customer -->
<FILE>CBASE_Custom_Wrappers.vbs</FILE>

<!-- GS_Kernel - Core Feature to handle SAP Gui Session and retrieve GuiScripting Objects -->
<FILE>GS_Kernel.vbs</FILE>
<FILE>GS_Common.vbs</FILE>
<FILE>GS_Utilities.vbs</FILE>
<FILE>GS_DataSource.vbs</FILE>

<!-- CBASE_HotFixes.vbs is delivered empty by official SAP TAO Releases -->
<FILE>HotFixes\CBASE_HotFixes.vbs</FILE>
</FILES>
```
3.5.7 Checking the CBASE consistency

This chapter describes an optional verification step. It makes sense if you have declared additional libraries in the CBASE or added some custom code.

As a matter of fact, loading custom libraries may introduce conflicts with the one that SAP TAO delivers by default. One could check for conflicts or syntax errors by executing the CBASE_Bootstrap.vbs file (double-click on it in the Windows file explorer). Starting this script should not display any error and a popup will let you check the list of libraries that have been loaded.

![Figure: List of declared CBASE libraries](image)
### 3.5.8 Checking the SAP TAO Setup using the Self Checks

Once you have performed all the steps related to your case, please make sure SAP TAO is properly setup using the SAP TAO Self Checks. The Self Check result should not report any errors.

![SAP TAO Self Checks](image)

**Figure: SAP TAO Self Checks**

### 3.5.9 Checking the SAP TAO Runtime Library using the PFA

The best way to make sure that the CBASE is consistent and that the new Default Components are at the right location in SAP Quality is to create a new Test out of a recorded business scenario. This is typically done using the PFA (Process Flow Analyzer).

Please proceed as described below:

- Start SAP TAO 2.0
- Navigate to the Design Module
- Select a Transaction Code
- Press the “Start” button in the PFA tab to begin the recording activities.
- Perform some very simple operation in the SAP GUI window.
- Stop the recording via the “PFA Control” dialog
- SAP TAO should display the recorded scenario as a PFA.
- Press the “Upload” button to generate the corresponding Test into SAP Quality Center.
- Then navigate to SAP Quality Center and execute the Test that has just been created.
- Make sure the Test succeeds by checking the generated SAP TAO Report

**PFA Configuration**

The screenshot below shows how the PFA must be configured to be able to generate Tests in SAP Quality Center. The “Path to Default Components” must refer to the appropriate folder of your QC Project.
3.5.10 Checking the Execution of Former Tests

Execute the Tests created with the previous SAP TAO version to make sure that the upgrade has been properly done. All Tests should be executable and generate a successful TAO Report.
3.6 Compatibility Matrix between SAP Solution Manager, SAP Quality Center by HP, Adapter and SAP TAO

In order to retrieve the latest version of the compatibility matrix, perform the following:

- Navigate to [http://service.sap.com/saptao](http://service.sap.com/saptao)
- Click on “SAP TAO How to Guide” at the bottom of the page.
- Expand the “Test Management” node
- Click on “Compatibility Matrix SAP Sol Man, SAP QC, Adapter & SAP TAO”

**Figure: Compatibility Matrix on SAP Service Marketplace**
# 3.7 Checklist for SAP TAO Configuration

<table>
<thead>
<tr>
<th>System</th>
<th>Item</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager</td>
<td>Solution Manager 7.0 SP 25</td>
<td></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td>ST-Tag Component (ST-Tag 200) is installed in the SAP Solution Manager system. Prerequisites for ST-Tag are: ST 400 SAPKITL430 (Support Package 25) ST-PI 2008_1_700 SAPKITLRD1 (Support Package 03)</td>
<td></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td>Do IMG Configuration for SAP TAO</td>
<td></td>
</tr>
<tr>
<td>Managed System</td>
<td>Latest ST-PI is installed on the managed system. Support Package 03 for ST-PI 2008</td>
<td></td>
</tr>
<tr>
<td>Managed System</td>
<td>Enable Scripting via Transaction &quot;RZ11&quot;</td>
<td></td>
</tr>
<tr>
<td>Managed System</td>
<td>Enable Scripting through the toolbar --&gt; Customize Local Layout --&gt; Options --&gt; Scripting Tab</td>
<td></td>
</tr>
<tr>
<td>Managed System</td>
<td>Fix defect of screen mismatch between manual analysis and PFA Analysis by applying note 1390205</td>
<td></td>
</tr>
<tr>
<td>Desktop</td>
<td>Quicktest Professional (QTP) is installed on Desktop/Laptop</td>
<td></td>
</tr>
<tr>
<td>Desktop</td>
<td>Quality Center Client is installed on the Desktop/Laptop</td>
<td></td>
</tr>
<tr>
<td>Desktop</td>
<td>Microsoft .Net Framework (2.0)</td>
<td></td>
</tr>
<tr>
<td>Desktop</td>
<td>SAP TAO Front End is installed</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP has SAP Add-In installed</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP has proper license, seat or concurrent license</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP is connected to Quality Center via Menu --&gt; File --&gt; Quality Center Connection</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP has permission to run test from Quality Center - Menu --&gt; Tools --&gt; Options --&gt; Run</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>Application Area _SAP_Doc is created from QTP, after connecting to quality center</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP has SAP Quality Center Connectivity add-in</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>QTP has SAP Quality Center System Test Remote Agent add-in</td>
<td></td>
</tr>
<tr>
<td>Desktop/QTP</td>
<td>Install all the latest patches for QTP</td>
<td></td>
</tr>
<tr>
<td>Quality Center Server</td>
<td>Quality Center has BPT Module installed</td>
<td></td>
</tr>
<tr>
<td>Quality Center Server</td>
<td>Set the following parameters DISABLE_EXTENDED_STORAGE=N BACKWARD_SUPPORT_ALL_DOMAINS_PROJECTS=Y</td>
<td></td>
</tr>
<tr>
<td>Quality Center Server</td>
<td>Upload the file &lt;RTL_Installation Folder&gt;\CBASE\CBASE_Init.vbs.txt to your SAP Quality Center</td>
<td></td>
</tr>
<tr>
<td>Quality Center Server</td>
<td>Check whether right path is present for the library components (QC--&gt; Test Plan --&gt; Subject\Design; QC--&gt; Test Plan --&gt; Subject\Consolidated; QC--&gt; Business Components --&gt; Consolidated)</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Proper path to RTL is given during the installation of TAO Frontend</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Create a folder SAPTAORTL in the path specified during installation. Copy the CBASE_Default folder as &quot;CBASE&quot; under &quot;SAPTAORTL&quot; Folder</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Connected to Solution Manager 7.0 SP 25 from Configuration--&gt; License Tab</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Connected to Managed system from Connect module of TAO</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Connected to Quality center from connect module of TAO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a) Connected to Quality Center Domain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b) Connected to Quality Center Project</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Export Library components from &quot;C:\Program Files\SAP\SAP TAO\Components_Default\Components&quot; to QC</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Encode password (Managed System Login Password) using password encoder tool of QTP for use within the datatable/datasheet</td>
<td></td>
</tr>
<tr>
<td>Desktop/TAO</td>
<td>Run the self test in SAP TAO, and it shows passed</td>
<td></td>
</tr>
</tbody>
</table>
4 SAP TAO Functionalities

SAP TAO 2.0 functionalities are:-
- Process Flow Analyzer
- Inspection
- Run and Report
- Consolidation
- Export/Import
- Repository
- Self Check

To know in more details above mentioned features, kindly go through the user guide available at http://service.sap.com/instguides.

All the above mentioned functionalities could be accessed via the tabs present in the left panel of SAP TAO front end.
4.1 Process Flow Analyzer (PFA)

Steps for Process Flow analysis are:-

1. Go to Design module.
2. Click on New to add executable.
3. Select a executable e.g. VA01.
   Name for analysis is already populated with time stamp concatenated to it. You may change it.
4. Click on New in the PFA tab.
6. The transaction is launched on the managed system along with the following PFA controller.
7. Execute the process flow as a business user.
8. After executing the transaction completely, stop the PFA by clicking on “Stop the PFA” button in the PFA controller window.
9. A report is generated which captures the activities performed by business user.

10. Select the analysis just created and choose Upload.

The upload activity will upload components for the screens touched by user, to SAP Quality Center and creates a parameterized test case. A excel is created where the values entered by the user are captured. The draft test cases will be having the library components e.g. Initialize script, launch and log on etc.

The spreadsheet will be created in the location specified in the PFA tab of configuration of SAP Test Acceleration and Optimization. The location is specified in the Data Folder field.
11. If the upload invalidates few consolidated components, then they are shown in a pop up, and can be added to the consolidation list.

Note:
Two validation components “CheckTransactionCode” and “GetMessageParameters” are added by default. The “CheckTransactionCode” validation component checks whether the transaction e.g. VA01 has been successfully started and “GetMessageParameters” default components ensures that the transaction has completed as desired.

4.1.1.1 Check Picker

The process flow analysis functionality has ability to insert check points in the test cases. The end user can insert suitable check points while recording a process flow analysis and can provide suitable conditions. The checkpoints are inserted as components in the SAP TAO generated test cases in SAP Quality Center. Of course, the test fails if the check point fails.
It is possible to check the value of many properties exposed by the SAP GUI scripting APIs of a UI control and the main comparison operators are permitted by SAP TAO are:

- equals ("=")
- greater or equals (">=")
- greater (">")
- less or equals ("<=")
- less (<)
- different ("<>")

When the check point is created, the value of the selected property is automatically retrieved and is set by default.

**NOTE:**
Please keep in mind that the purpose of the Check Picker is to validate output values as they are displayed by the application after a round-trip to the backend system. Checking input values (i.e.: values that have just been entered by the test engineer) does not make sense and may have a side-effect at runtime because the check itself will be performed before setting the value.

**Inserting checkpoint using Process Flow Analysis**
1. First, this functionality needs to be enabled. By default it is the case, but it can be configured through the SAP TAO configuration, in the PFA tab with the “Enable Check Picker” radio button.
2. Start process flow analysis of any transaction.
3. In the PFA Controller, click on Add Checkpoint.
4. Point the mouse to the screen element which needs validation. The highlighted screen element will have a red border.
5. In the PFA Controller -> Check Picker, choose the property which needs validation. By default, a suitable property, operator and value are chosen.

4.2 Test Component Generation

4.2.1 SAP TAO Inspection

The Inspect module in the SAP Test Acceleration and Optimization client enables you to select multiple SAP GUI screens and transactions for testing in an easy to use interface. It then determines whether these screens and transactions are valid and uploads them as business components in SAP Quality Center.

The steps for inspection are:-

1. Go to Design module.
2. Click on New to add executable.
3. Select an executable e.g. VA01.
4. Go to Inspection tab.
5. To create components and upload them to SAP Quality Center, choose “Inspect”.

© 2011 SAP AG
6. If the upload invalidates few consolidated components, then they are shown in a pop up, and can be added to the consolidation list.

7. To get the status of inspection Click "View Report". It helps to know errors in inspection.

8. If the inspection invalidates few consolidated components, then they are shown in a pop up, and can be added to the consolidation list. This happens if the inspected component is already getting used in a test case which is consolidated.

### 4.2.2 SAP TAO UI-Scanner

The UI Scanner enables you to collect information from one screen at a time and sends the screen objects to SAP Quality Center as a component. By default, this functionality disabled in SAP TAO 2.0 SP06. It can be enabled from SAP TAO configuration. Please see the following screenshot:

The UI Scanner scans all objects on the screen including dynamically generated objects. The UI Scanner needs a running QuickTest Professional (QTP) installation on system where SAP TAO is running.

**Steps for UI Scanning are:-**

1. Go to UI Scanner tab in the Design module
2. Click on “Launch Scanner”. Ensure that only one SAPGUI session is running for your managed system.

3. Choose .

4. To end the scan, choose .

The UI screen will be scanned and will be uploaded to components module of SAP Quality Center. It would reside in the folder SAP Front End\Transactions\<T Code>.
5. If the UI-Scanning invalidates few consolidated components, then they are shown in a pop up, and can be added to the consolidation list. This happens if the re-UI Scanning is done for a component which is already getting used in a test case which is consolidated.
4.3 Run and Report

Run and report module is used to execute SAP TAO based test cases to create TBOMs. This module also gives easy access to SAP TAO based logs.

4.3.1 Important features of Run List

Run list has many important features and they are as follows:

1. **Possibility to pause a run list execution**: This feature actually pause the run list at a logical point. If the user presses Pause in mid of a test case execution, than run list will pause after execution of the current test case is finished.

2. **All Run list execution automatically creates a test set in a specified location in SAP Quality Center**. The location of the run list test set can be configured in SAP TAO configuration.

3. **Explicit save of the run list**: Run list could be explicitly save by the user by clicking on the save button.

4. Run list could also be loaded from an existing test set in Quality Center.

5. It is possible to re-arrange test case by using up and down arrow.
4.3.2 Running a Test Case to Create a TBOM

The description in the present chapter is based on the assumption that all prerequisites described in the following chapters are met:

- “3.2.6 Roles on SAP Solution Manager and Managed Systems”
- “3.2.8 Prerequisites to TBOM creation from SAP TAO”

4.3.2.1 Preparing the Solution Manager project

Configuration check scenario

In order to verify the settings in a simple but real scenario, it is recommended to do the following check:

1. In your Solution Manager project, select an executable item.
2. Press the ‘Attributes’ button.

   The attributes popup will open. Go to the ‘TBOM’ tab.
3. Create manually a dynamic TBOM by pressing the ‘Record TBOM’ button.

   This should automatically log you into the Managed System and start the transaction of the executable item. **If automatically log on is not happening it means trusted RFC connection is missing and it should be created.**
4. Run a small business process example and confirm the TBOM creation at its end.
5. Verify that a TBOM entry has actually been created on Solution Manager System.

   In case the ‘configuration check scenario’ did not successfully create a TBOM, then you need to solve this problem first. SAP TAO won’t be able to create TBOM either.
Following check should be done if TBOM creation if manual TBOM creation from SAP TAO fails:

**Check 1 - Existence of appropriate executable item in Solution Manager Project**

Ensure that on your SAP Solution Manager an appropriate business blueprint structure exists and that it contains the executable item(s) for which you want to create the TBOM(s).

Log on to your Solution Manager using the same user Id as you use in SAP TAO (set in "configuration – licensing" in the SAP TAO client). Open the SAP Solution Manager project you intend to process (transaction SOLAR01) in order to view the 'Logical Component' and it’s 'System Role'.

![Logical Component Screen Shot](image)

In the above given screen-shot, the configured logical component is ‘Z_QB2_SMY’ and the user-specific system role is ‘Quality Assurance System’.

**Check 2 - Verify validity of Logical Component**

The following is describes how to verify that the executable item is configured correctly in order to allow TBOM creation by SAP TAO. **Note that this verification is only necessary once for a set of attributes “SolMan User Id / SolMan project / logical component”**.

Verify in SMSY that the executable item contains the product system which points to the physical system where later on the test shall be executed. In case when more than one product system is configured in the logical component, then the user-specific ‘system role’ will be used to determine the target product system. In the present example the system role is set to be "Quality Assurance System", thus SAP TAO will use the highlighted entry of the Logical component Z_QB2_SMY:

![Product System Screen Shot](image)

**Hint**
In case there is exactly one product system assigned to the Logical Component, then SAP TAO will use that system without regards to the active System Role.

Double-clicking on the highlighted entry will navigate to a table showing the system landscape. Select the entry containing the ‘relevant ECC’ server and its configured RFC destinations will be shown. In the context of TBOM creation we are interested in the “Trusted System RFC” which you already have verified in before.

![System Landscape](image)

### 4.3.2.2 Associating a Test

SAP TAO based test cases can be reused to create TBOMs. TBOMs are created in SAP Solution Manager, and can be viewed in Business Blueprint (SOLAR01). In order to define where a test case shall create / update TBOM later-on, a link between the test case and the business blueprint executable must be established, a so called „association for TBOM“.

You need to take care that you choose a test case which represents the typical user activity on the executable. The risk for an invalid mapping is that if you associate a test case which does not represent the appropriate scenario, then the TBOM will not contain the right objects.

**Procedure:**

Identify the appropriate test case which shall be associated to the business blueprint executable. Open SAP TAO; go to the ‘Run and Report’ section.

- a) Select the test case
- b) Click on the icon ![icon](image) in the Tests tab, or select the entry ‘Associate for TBOM creation’ of the context menu of the test. The association popup will open.
c) Select the SAP Solution Manager project which contains the executable item to which the association shall be made.

- Select the executable item. In case of huge projects it is recommended to activate the 'Filter on Object Name' in order to ease the finding of the right executable. Select the desired executable and press the 'Associate' button in order to create the association.

Please note that in order to become 'executable for TBOM creation', several conditions must be met where the existence of an association is only one of them. For example, it is possible to establish an association without being connected to any Managed System, but in order to become executable, the connection to the appropriate Managed System is mandatory.
4.3.2.3 Executing the Associated Test

Once all conditions, which make a test case executable for TBOM creation, are met the corresponding
the menu button and its context menu entry of the test case become activated.
The following options for creation/update of TBOM do exist:

1. The test case can be executed manually, for this select the test at the Tests tab of Run and
   Report module and click on . Note that this is also possible via the context menu
   associated to the test.
2. The test case can be added to a run-list which allows the execution of multiple test cases in
   one run. You can either add tests one by one to a run list, or you can select complete folders.
   Select the tests/ folders you are interested in and click on . Switch to the 'Run List' tab,
   select the tests to want to execute and select its 'Create TBOM' checkboxes in order to
   request TBOM creation during the test execution.

Then press in order to execute.

SAP Test Acceleration and Optimization

Notes:

- In case a dynamic TBOM created by the same test case in a former run already exists, then
  the re-execution of the same test case will update the existing TBOM.
- In case a dynamic TBOM exist, but it was NOT created by the same test case by SAP TAO
  TBOM functionality, then the 'Execution for TBOM creation' will lead to creation of a TBOM
  enhancement. Those enhancements are not visible by default in the main TBOM tab (see
  FAQ for hints).
- To be able to follow detailed information about the TBOM creation progress, it is
  recommended to activate the Information Display via SAP TAO Configuration – Log –
  “Options: Display Information Box”.
- Higher level test cases (e.g. O2C test case) cannot be used to create TBOM for lower level
  process steps (e.g. VA01 Create Sales Order). A SAP TAO based test case is needed for
4.4 Consolidation of Tests

Consolidation has two benefits:

1. It makes a test case better for execution, so it becomes faster.
2. It creates a component out of a test case, so that it could be used to compose other test case.

Important configurations for Consolidation

1. Automatic update of data table: This will automatically update the Excel data file with new column name if a field, which is not present in the Excel data file, is found.
2. Creation of test case which will use this component: This helps in the execution of a test case.

Consolidation can be initiated by:

- Select by Test Tab
Select by Component Tab

4.4.1 Select by Test:
In the consolidate module go to “Select by Test” tab. If SAP Test Acceleration and Optimization is not connected to SAP Quality Center, then user would be forced to connect to use this functionality. Once connected, you can view the folder structure of the component module of SAP Quality Center.

4.4.1.1 Consolidation

Select a test and click on “Add to Consolidation list”. By default, all the child test cases are added to consolidation list.

Example: If VA01 Consolidated component is used in O2C Test Case, and O2C is again consolidated, then if VA01 test case is added to consolidation list with “Add Dependent Tests” checked, even O2C Test Case would be added to the consolidation list.

4.4.1.2 Invalidate

You can select multiple test cases, and click on the button “Invalidate”, and mark all the dependent test cases for consolidation. The pop up shows the entire dependent test cases, and could be added directly for consolidation.

This feature is beneficial if test cases are changed in quality center.

Example: If VA01 Consolidated component is used in O2C Test Case, and O2C is again consolidated, then if VA01 test case is manually invalidated, even O2C Test Case would be marked for consolidation.

4.4.1.3 Identify Dependent tests

You can select a test case and click on the button “Identify Dependent Tests” and it will show all the test cases which are making use of the test cases consolidate component.
Example: VA01 consolidated component is used in O2C Test Case and O2C is again consolidated. If VA01 is selected and “identify dependent tests” button is pressed, a pop up window appears to show the dependent test cases, which are VA01 and O2C. These test cases could also be added for consolidation directly from the pop up.

Figure: Indentify Dependent Tests

4.4.1.4 Update Iterations
The functionality enable the SAP TAO generated test cases to run for all the rows entered in the associated data excel.

Figure: Select the test case and click on Update Iterations button
4.4.1.5 Update Data Table

This functionality compares the fields referenced in the data table with the ones mentioned in the selected test case. If the test case has more fields, then it is added to data table.
In the above example, a field has been parameterized in Test Case but it’s not added to the data table reference by the test case. Now, DT_VA01_0101_DIVISION is added as a column in the data table.

4.4.2 Select by Component

In the Consolidate module goes to “Select by Component” tab, and then you can see components present in the components module of SAP Quality Center. Select a component and you will be able to see all the tests which are using this component. Select one or more tests, and choose “Consolidate”.

![Figure: Update Data table](image-url)
Figure: Consolidation by Component
4.5 Change Analyzer

Change analyzer functionality helps in repairing tests, which are impacted by a software change. SAP Test Acceleration and Optimization relies on SAP Solution Manager – Business Process Change Analyzer (BPCA) result. The BPCA result Id could be searched on the basis of a solution or project.

Figure 4.1: Change Analysis

Steps for Change Analysis:
1. Input your result Id, and choose “Change Impact Analysis”.
2. List of impacted components (including consolidated components) are shown in the Impacted Components tab. Impacted Test tab shows are all the affected tests.
Figure 4.2: Viewing impacted components

3. The user can select the impacted components and choose “Repair”. If basic components are selected then repair task is re-inspection and if consolidated component is selected then repair task is reconsolidation. Once the repair is over, the components are flagged “Repaired”. Even without performing the reparation task, a component could be flagged repaired using context menu.
4.6 Repository

Repository module gives access to SAP TAO repository stored in SAP Solution Manager.

4.6.1 Component Explorer

The user can see the list of all the components created by himself for a specified QC Domain and QC Project.
4.6.2 PFA Explorer

The user can search for PFAs created till now, depending on search strings. The user can specify property to search on. The different properties which are possible to be searched on are:

- User
- Analysis Name
- Transaction
- System
- Client
- Date Time
- Language

Once the search is done the user can click on one of the PFA to see more technical details.

4.6.3 Repository Synchronization

This functionality helps in synchronizing the SAP TAO data base with SAP Quality Center component data base.

4.6.3.1 Enable Repository Synchronization

Navigate to Configuration -> Import/Export and Enable Repository Synchronization Tool.
4.6.3.2 Perform Repository Synchronization

Steps to do repository synchronization are:-

1. Click on "Get Data".
2. The user can see missing and orphan components.
   a. Missing Components: Missing components are the components which are present in SAP Quality Center but not present in SAP TAO repository. These components need to be replicated in SAP TAO data base as well.
   b. Orphan Components: These components are present in SAP TAO data base, and not in SAP Quality Center. These component needs to be deleted from SAP TAO database as well.
3. Propose Missing Data button will show the missing data in the table. The user can edit the missing data by clicking on the Edit Button.
4. The user can select the multiple missing components and click on the repair button.

5. The user can select multiple orphan components and click on Repair button. This activity will actually delete the component from SAP TAO data base.

4.7 Self Check

Self check functionality will check that all the setup and configuration required for SAP TAO is done. Steps to do self check are:-

6. Click on the Self Test Tab
7. List of “Self check” items are shown.
8. User can select one item and validate it.
9. The user can initiate “Self Check” for all the items.
4.8 Object Spy

Object Spy is used to learn the properties of UI elements on the screen. 

Steps for to use Object Spy are:-

1. Launch the SAPTAO Application.
2. Launch Sap Logon, connect to a SAP system with scripting enabled, enter user/password and launch a transaction.
3. In SAP TAO, click on the link labeled “Object Spy” in the upper right corner. The object spy dialog should appear.
4. In the object spy dialog, all existing Sap Gui sessions, with scripting enabled, are listed in the dropdown list located in the “Active connections” group box: the system, transaction and user should be displayed just below this list. The program name and the screen number of the selected session should also be displayed in the “Session info” group box.
5. A preview picture of the selected Sap Gui session should also be displayed in the “Active connections” group box.

![Active Connections in Object Spy](image)

6. Press the button labeled “Spy” in the bottom area and go back to the Sap Gui window.
7. Move the mouse over the Sap Gui window. Controls located under the mouse should be highlighted in red. Click on one control and the highlight mode should stop.
8. Go back to the object spy window. All the properties of the selected control should be listed at the bottom.
Since SPA TAO 2.0 SP4, the Object Spy, integrated in SAP TAO SP4, offers new capabilities:

- Spy results are now displayed in a tree-list.
- Some sub-items are grouped in nodes to improve the readability.
- Previous spy results are collapsed and kept in the result tree.
- It is possible to locate the Sap Gui control which has been spied by a right-click on a spy result.
- It is possible to list all Sap Tao RTL components related to a UI control which has been spied.
A right-click on a spy result allows to locate the targeted SAP GUI control and to display the list of its related RTL components.
All RTL components delivered with Sap Tao SP4 and related to a specified SAP GUI control type are listed in this view.

For ALV controls, the identifiers of its sub-items are displayed in sub-nodes, for example, here in the ALV toolbar, the menu-item “Project”, of the button-menu which has the tooltip “Create”, has the identifier “CREATE_PRJ_NEW”. 
4.8.1 Spying an ALV control

The ABAP List Viewer (ALV) is a generic tool that can be used to output data in tabular form and is increasingly used by the applications particularly as of Release 4.6C of Sap Gui. By using the ALV, general functions are provided (for example, exporting to Excel) and it is possible to adapt the output to customized requirements (for example, sorting, filters, totals calculation). There are different types of ALV, for example trees, grids, etc.

Since SAP TAO SP2, it is possible to spy a particular object inside an ALV control, for example a single node of an ALV tree.

Figure: The key, text, path and column of the selected node are displayed.

N.B.: It is essential to keep all spaces and special characters when copying something from the column ‘Value’. All values are displayed exactly as they have to be passed to a default component.

4.9 SAP TAO Log

Each time a SAP TAO based scripts are executed, SAP TAO logs are created in the SAP TAO Runtime Library Folder, E.g.: If SAP TAO RTL Folder is C:\SAPTAORTL, then logs are kept in C:\SAPTAORTL\Logs.
4.9.1 Accessing logs from SAP TAO frontend

SAP TAO provides a new module Run and Report which enables end user to execute SAP TAO scripts and also view SAP TAO logs. Wherever the test has been executed from, via Test Lab module of SAP Quality Center or using SAP TAO, the logs can be viewed in SAP TAO frontend.

Steps to access logs for a test case execution:

1. Select a test case.

2. Select a specific test set

3. View the executions logs.
SAP Test Acceleration and Optimization

It is possible to arrange the columns and see only specific steps. It is also possible to save the change in the view. Even the SAP TAO xml log file could be directly accessed by clicking on HTML report.
4.9.2 Accessing SAP TAO logs (log xml file)

To access the logs xml file the user, has to come to specified log folder, and find the logs for his execution run. He could also navigate to the specified folder by going through run and report module or using Report folder link.

![Log Folder Image]

**Figure: Log Folder**
If he has done the execution of a business process test from Test Plan module, then a folder “BusinessProcess_YYYY-MM-DD_HH-MM-SS_Test Case Name” is created. The time stamp of the start of the execution of business process is appended in the name of the log folder.

In this folder user has to open the file ReportLog.xml in Web Browser, and he can view the content of the entire log file. The log file is an xml file on which log.xslt style sheet is applied.

For a test set run from test lab module, a folder with “TestSet_Test Set name” is created in the log folder of RTL folder.

For a business component run from QTP, a folder with “BusinessComponent_YYYY-MM-DD_HH-MM-SS_Test Component Name” is created in the Log folder of RTL folder.

**Figure: Log File**
5 Example for Test Case Creation

5.1 Example Scenario

In this example, we will learn how to create a composite script, where we link Create Sales Order and View Sales Order. This example will demonstrate how to pass parameters from one script to another.

The following steps are described:

1) Test case creation for Create Sales Order
2) Test case creation of View Sales Order
3) Creation of composite test case, which links Create Sales Order and View Sales Order test cases.

5.2 Test Case Creation for “Create Sale Order”

5.2.1 Process Flow Analysis for Create Sales Order Transaction (VA01)

In this example, we will use the process flow analysis functionality of SAP Test Acceleration and Optimization, to record a transaction. This functionality records the execution flow and stores the recorded information in a repository, which resides in SAP Solution Manager.

2. Choose the “New” pushbutton in the transaction list screen area.
3. Enter the transaction code VA01.
4. Choose “OK”.
5. In the “Executable Objects” screen area, select the transaction VA01.
6. Click on “New” in Process Flow Analysis tab, enter the name as Create Sales Order.
7. Choose “Start”.

![Execution Object Creation](image-url)
8. Enter the following data in the initial screen,
   - “Order Type”: OR
   - “Sale Organization”: 1000
   - “Distribution Channel”: 10
   - “Division”: 00

9. Press “Enter”

10. In the second screen, enter the following data:
    a. “Sold-To Party”: 1000
    b. “Ship-To Party”: 1000
    c. “Material”: P100
    d. “Quantity”: 1

11. Choose “Save”.

“PFA Control” window will pop-up.

The transaction VA01 is started and initial screen is shown.
12. In the “PFA Control” window, choose “Stop the PFA”.

13. In SAP Test Acceleration and Optimization client, select “Create Sales Order” in the existing analysis.
14. Choose “View Structure”.
15. Expand the screen elements, 0101,4001,4021,4701 and 4900.
The above structure shows the flow of Create Sales Order transaction, as recorded by SAP Test Acceleration and Optimization. Certain data was entered on screen 0101 (initial screen) and “Enter” was chosen. After entering ship to party, sold to party, PO number, material and quantity, “Save” was chosen. The Sales Order number 13130 was created in this recording.

16. Note down the sales order number shown in the report, which will be used the exercise 2.

5.2.2 Upload of Process Flow Analysis of Create Sales Order Transaction (VA01)

2. Choose “Upload”.
3. In the “SAP TAO” dialog box, choose “Yes”.

4. Once the upload is done, view the upload report by clicking on a link near the upload status bar.

   Notice that the screen components are inspected for the test system (ERP) and are uploaded to SAP Quality Center.

5. Close the “Process Flow Analyzer Upload Status” report window by choosing “Close”.
6. On the top right corner of SAP TAO client, click on “SAP Quality Center”.

   The SAP Quality Center will get launched in the Microsoft Internet Explorer web browser.
7. Provide the login credentials in the SAP Quality Center.

![Login credentials in SAP Quality Center](image)

8. Navigate to the test plan module by clicking on ![Test Plan](image) in SAP Quality Center.

![Test plan module in SAP Quality Center](image)

10. In the “**Design**” folder, choose “**Create Sale Order**” test case.
11. To open the data file, navigate to location specified in "**DataTablePath**" field of InitializeContext. The path would be

```
DataTablePath: C:\Documents and Settings\student\local\Settings\Temp\SAPTAOWORK\DATA\DT_Create_Sales_Order.xis
```

Alternatively, one can also navigate to the data file from Run and Report module of SAP TAO. Select the test and click on **μ**.
5.2.3 Storing sales order number in the data excel

1. Drag and drop the getMessageParameter component in the suitable location of the test case. Generally, it would be dragged and dropped before automatically added GetMessageParameters component.

2. Same URI of getMessageParameters component can be provided to getMessageParameter component. Suitable index should be used for storing the value. This index could be found by using QTP object spy. The index in the case of standard VA01 transaction is 1. TargetField is the DT_XXX which is a column name in the data excel.

5.2.4 Adding manual validation on the status bar

1. While recording the PFA use the CheckPicker functionality to inject the CheckProperty component for status bar validation.

2. After the PFA upload, the check property component will be introduced after GetMessageParameters component.

3. Modify the data excel to capture suitable string for validation
The context parameter %VA01_MessageParameter1% can be noted from the PFA Details tab, which shows the structure.

Note:

For version lower than SAP TAO 2.0 SP06, the token can found by executing the SAP TAO based test case once as it is available in SAP TAO logs.

To execute the test case correctly, the test designer might have to run the test case without this check first.
5.2.5 Consolidation of Create Sales Order test case

**Introduction to Consolidation:** This activity in SAP Test Acceleration and Optimization creates a component out of a test case, which has following benefits:

- It makes a test case better for execution, so it becomes faster.
- It creates a component out of a test case, so that it could be used to compose other test cases.

The steps for consolidation are:

3. Choose **Consolidate** in SAP Test Acceleration and Optimization client.
4. In the “Select by Test” tab page, choose “Subject”->”Design”->”Create Sales Order”.

5. Choose
6. Click on the “Consolidation List” tab page. Ensure that the “Create Sales Order” test case is selected.

7. Choose
8. Once the consolidation is complete, check the status of consolidation by clicking on **View Report**.
5.2.6 Execution of Create Sales Order Test Case and Viewing HP QuickTest Professional Execution Logs

1. Navigate to Test Lab module of SAP Quality Center by clicking on Test Lab.
2. Create a folder by clicking on .


5. Double click on the “Create Sales Order” test set.
6. In the “Execution Grid” tab page.
7. Choose Select Tests.
8. Select the “Test_Create Sales Order” test case from the “Consolidated” folder.
9. Add this test case to the execution grid by double clicking on it.

10. Select the row with “Test _Create Sales Order” in the execution grid.

“Automatic Runner” window will appear.
12. Select the “Run All Tests Locally” checkbox and keep the “Enable Log” checked.
13. Choose Run All.
The execution of Create Sales Order (VA01) transaction will start after some time. The VA01 transaction will get executed as recorded. The status of “Test_Create Sales Order” test case will change to “Passed”.

14. Close this window.

The status of “Test_Create Sales Order” test case will change to “Passed” in Execution Grid as well.

15. To view the HP QuickTest Professional Logs, double click on “Test_Create Sales Order” row.

16. In the “Test Instance Properties” window, double click on the first row.

17. In the same window, double click on the link.

![Diagram](https://example.com/diagram.png)
HP QuickTest Professional Log will appear.
5.2.7 View SAP TAO logs

Navigate to Run and Report module of SAP TAO, and select the test case Test_Create Sales Order. Select a latest test set, and see the SAP TAO logs.

5.3 Test case creation for “View Sales Order”

5.3.1 Process Flow Analysis of “View Sales Order” Transaction (VA03)

2. Choose the “New” pushbutton in the transaction list screen area.
3. Enter the transaction code VA03.
4. Choose “OK”.
5. In the “Executable Objects” screen area, select the transaction VA03.
6. Click on “New” in Process Flow Analysis tab, enter the name as View Sales Order.
7. Enter the sales order number generated in recording of “Create Sales Order”.
8. Choose “Search”.
In the “PFA Control” window, choose “Stop the PFA”.

In SAP Test Acceleration and Optimization client, select “View Sales Order” in the existing analysis.

Choose “View Structure”.

Click and expand the screen elements, 0102.

Close the window after verifying the structure.
5.3.2 Upload of Process Flow Analysis of “View Sales Order” Transaction (VA03)

1. Select the “View Sales Order” in the existing analysis box.
2. Choose “Upload”. A pop up box will appear to confirm the upload.
3. Choose “Yes”.
4. Once the upload is done, view the upload report by clicking on a link View Upload Report near the upload status bar. Notice that the screen components are inspected for the Test System (ERP) and are uploaded to SAP Quality Center.

5.3.3 Modification of a Parameter in “InitilizeContext”

1. Close the report.
2. Click on SAP Quality Center link on the top right corner of SAP Test Acceleration and Optimization client. The SAP Quality Center is launched in the Microsoft Internet Explorer web browser.
3. Provide the login credentials in the SAP Quality Center.
   a. “Login Name”: Tester_XX
   b. “Password”: taotao
   c. Deselect the “Automatic log in to last domain and project on this machine” checkbox.
   d. Select “Domain”/“Project”: TechEd_10/Project_XX
4. Navigate to the test plan module by clicking on in SAP Quality Center.
5. Choose to “Subject”->“Design”->“View Sales Order”.
6. In the first component, “InitilizeContext”, replace the value in the field “TestOptions” with “/c”.

© 2011 SAP AG
5.3.4 Consolidation of Create “View Sales Order” test case

1. Choose in SAP Test Acceleration and Optimization client.
2. In the “Select by Test” tab page, choose “Subject”->”Design”->”View Sales Order”.

3. Choose
4. Select tab page “Consolidation List”.
5. Check that “View Sales Order” test case is selected.

6. Choose
Once the consolidation is complete, check the status of consolidation by clicking on View Report.

5.4 Creation of Composite Test Case

5.4.1 Creation of a composite business process test case

1. Navigate to the test plan module by clicking on \Select by Test in SAP Quality Center.
2. Choose “Subject”->“Design”->“View Sales Order”.
4. Using the secondary mouse button, choose “New Test”.

5. Select “Business-Process” as the “Test Type”.
6. Enter “O2C” as the test name and choose ok. Click on “Test Scripts” tab. In the components tab, select “Create Sales order” test case and choose ¦. Then select “View sales order” and choose ®.
7. Open the data table file for View Sales Order, which will be available at the location "c:\Documents and Settings\student\Local Settings\Temp\SAP\TAO\WORK\DATA"
8. Open the DT_View Sales Order.xls file and enter %VA01_MessageParameter1% in the column DT_VA03_0102_SALES_DOCUMENT. The information on the parameter name could be capture by checking the structure of “Create Sales Order” process flow analysis.
5.4.2 Consolidation of Composite Business Test Case

1. Click on the icon \[\text{Consolidate}\] in SAP Test Acceleration and Optimization client.
2. In the “Select by Test” tab page, choose “Subject”->“Design”->“O2C”.

3. Choose \[\text{Add to consolidation list}\].
5. Ensure that the “O2C” test case is selected.

6. Choose \[\text{Consolidate}\].

5.4.3 Execution of Composite Business Case and Viewing HP QuickTest Professional Logs

1. Navigate to Test Lab module of SAP Quality Center by clicking on \[\text{Test Lab}\].
2. Navigate to the folder “Tech Ed 2010”.
3. Create a new Test Set in the folder “Tech Ed 2010” by clicking on \[\text{Create Test Set}\]. Give the name of the test set “O2C”.
5. In the “Execution Grid” tab page, click on “Select Tests” button.
6. Select the “Test_O2C” test case from the “Consolidated” folder.
7. Add this test case to the execution grid by double clicking on it.
8. Select the row with “Test_O2C” in the execution grid.


The “Automatic Runner” window appears.

10. Select “Run All Tests Locally” and keep the “Enable Log” checked.

11. Choose Run All

The execution of O2C scenario will take some time to start. The O2C Scenario will get executed. The status of “Test_O2C” test case will change to Passed. Close the “Automatic Runner” window.
12. In the “Execution Grid” tab page, double click on the first row.

13. In the “Test Instance Properties” window, double click on the first row.
14. In the same window, double click on the link at the bottom.
6 Repairing SAP TAO Test Cases

6.1 Introduction to different change types

Lot of times SAP TAO based test cases would not run successfully, as they are damaged due to software changes introduced in the landscape. The following section explains how SAP TAO based test cases can repaired in easy manner. Following are the 2 kinds of changes which may damage the test cases:

1. Custom code change: Such kind of changes may introduce new mandatory fields or make the existing field mandatory for the user, hence the corresponding test case should be repaired to handle the change. If a new mandatory field is introduced in the screen, then its corresponding screen component needs to be re-created (re-inspected), so that a new parameter is introduced in the test component. If an existing field has become mandatory, recreation of the component is not required as it’s already present in the corresponding screen component. Later, the test cases should be tuned to handle the new parameter.

2. Customizing change: Such kind of change may also introduce new mandatory fields or make the existing field mandatory. In such situation, re-creation of the test components are not required, as by default SAP TAO always creates a component which has all possible fields. Only, the test cases should be tuned to handle the new parameter.

Example of SAP TAO screen component: The screen component for 101 screen of VA01 transaction, always have many parameters in the component, consisting even those which are not always shown on the screen. The following screenshot shows a standard 101 screen and its inspected component.

![Figure: Screen number 101 of VA01 transaction](image1)

![Figure: Inspected component for screen 101](image2)

We can obviously note that 101 screens shown to a user has 7 input fields while the inspected component has 9 parameters. The component is created considering all possible fields, so in many cases of customizing change re-inspection of screen components are not required.
The following graphic explains the general repair process of SAP TAO based test cases. Then later, we would see how different types of changes can be managed to repair the affected test cases.

6.2 Repairing Test Cases due to customizing changes

Customizing change is very common change in SAP Landscape, and it alters the way a user interacts with a system. Lot of times existing fields become mandatory or new fields are introduced in the existing flow of a transaction. Sometimes, changes are too drastic where new screens are introduced in the existing flow. If the identified changes are too drastic and create different test flows, it’s recommended to create a new test case using Process Flow Analysis.

The repair of test cases could be handled in the following ways depending on whether BPCA functionality is used or not:

1. Repair without BPCA integration
Many customers do not have pre-requisite met for BPCA, so they would repair the SAP TAO based automated test case by the following approach:

1. **Identify impacted test cases** – The test case impacted due to software changes have to be manually identified. The test engineer can seek this information from the introducer of the change or he may run important regression test cases to indentify the impacted ones.

2. **Execute the test cases** – The test case need to be executed once to check whether it’s really failing. If test case execution fails, test engineer makes note of the new input required. It might have happened that an existing field on the screen has become mandatory or new field has been introduced. The execution of the test case can also be done from SAP TAO’s Run and Report module.

3. **Repair the test cases** – Now the test case need to be modified to handle the input found in the step 2. Suitable parameter value should be provided for the field in the identified test case.

**Note:**
To accurately, identify the screen component needed for feeding this new value, the test engineer may need to check the technical information of the screen in the transaction. This way, he could accurately identify the screen number. If the equivalent component for the screen number is not present in the BPT module of SAP Quality Center, it is should be generated by SAP TAO Inspection functionality.

4. **Consolidate the test cases** - The test cases which were modified, needs to be consolidated, so that all the higher level test case can get the fixed component. The consolidation will automatically add one extra column in data excel for the new parameter value, e.g. DT_XXXX_XXXX.

5. **Provide input data in data excel** – The test engineer now needs to provide a suitable data in the data excel for the mandatory input field.

6. **Execute the repaired test case** – The repaired test case need to be executed once to check the fix done to handle this new input.

2. **Repair using BPCA Integration**

1. **Identify impacted test cases** – The impacted test cases can be easily identified in SAP TAO using its Change Analyzer module. In this module, the user provided the BPCA ID, which is generated in SAP Solution Manager. The id could also be easily searched.

2. **Execute the test cases** – The user can run the impacted test cases from SAP TAO itself, and he may not need to navigate to SAP Quality Center to execute them. This way he saves some time in navigating to SAP Quality Center UI. If test case execution fails, test engineer makes note of the new input required. It might have happened that an existing field on the screen has become mandatory or new field has been introduced.

3. **Repair the test cases** – Now the test case need to be modified to handle the input found in the step 2. Suitable parameter value should be provided for the field in the identified test case. The test engineer can also easily jump to the affected test cases in SAP Quality Center by clicking on them in SAP TAO change analyzer module.

**Note:**
To accurately, identify the screen component needed for feeding this new value, the test engineer may need to check the technical information of the screen in the transaction. This way, he could accurately identify the screen number. If the equivalent component for the screen number is not present in the BPT module of SAP Quality Center, it is should be generated by SAP TAO Inspection functionality.

4. **Consolidate the test cases** - The test cases which were modified, needs to be consolidated, so that all the higher level test case can get the fixed component. The
consolidation can be triggered from Change Analyzer module itself by clicking on repair component after selecting the consolidated component which is required to be updated.

5. **Provide input data in data excel** – The test engineer now needs to provide a suitable data in the data excel for the mandatory input field.

6. **Execute the repaired test case** - The repaired test case need to be executed once to check the fix done to handle this new input. The execution can be done by adding the test case to Run List from Change Analyzer module itself.

### 6.3 Repairing custom code changes

Many customers have lot of custom objects which has an UI interface. These UI interfaces may be changed directly by introducing new fields in the screen or by making existing fields mandatory. In this case, if new fields have been introduced, the screen components may need to be recreated so that it has the parameter for the new field.

The repair of test cases could be handled in the following ways depending on whether BPCA functionality is used or not:

1. **Repair without BPCA integration**
   - Many customers do not have pre-requisite met for BPCA, so they would repair the SAP TAO based automated test case by the following approach:
     1. **Identify impacted test cases** – The test case impacted due to software changes have to be manually identified. The test engineer can seek this information from the introducer of the change.
     2. **Execute the test cases** – The test case need to be executed once to check whether it’s really failing. If test case execution fails, test engineer makes note of the new input required. It might have happened that an existing field on the screen has become mandatory or new field has been introduced. The execution of the test case can also be done from SAP TAO’s Run and Report module.
     3. **Repair screen components** – The screen component needs to be re-inspected if new UI field has been introduced. In the case of existing fields becoming mandatory, re-inspection is not required.
     4. **Repair the test cases** – Now the test case need to be modified to handle the input found in the step 2. Suitable parameter value should be provided for the field in the identified test case.

   **Note:**
   To accurately, identify the screen component needed for feeding this new value, the test engineer may need to check the technical information of the screen in the transaction. This way, he could accurately identify the screen number. If the equivalent component for the screen number is not present in the BPT module of SAP Quality Center, it should be generated by SAP TAO Inspection functionality.

5. **Consolidate the test cases** - The test cases which were modified, needs to be re-consolidated, so that all the higher level test case can get the fixed component. The consolidation will automatically add one extra column in data excel for the new parameter value, e.g. DT_XXXX_XXXX.

6. **Provide input data in data excel** – The test engineer now needs to provide a suitable data in the data excel for the mandatory input field.

7. **Execute the repaired test case** – The repaired test case need to be executed once to check the fix done to handle this new input. The execution of the test case can also be done from SAP TAO’s Run and Report module.

2. **Repair using BPCA Integration**
   1. **Identify impacted test cases** – The impacted test cases can be easily identified in SAP TAO using its Change Analyzer module. In this module, the user enters BPCA ID, which is
generated in SAP Solution Manager. The id could also be easily searched by providing suitable SAP Solution Manager Projects or Solutions.

2. **Execute the test cases** – The user can run the impacted test cases from SAP TAO itself, and he may not need to navigate to SAP Quality Center to execute them. This way he saves some time in navigating to SAP Quality Center UI. There is possibility of adding impacted test cases to “Run List” in SAP TAO. If test case execution fails, test engineer makes note of the new input required. It might have happened that an existing field on the screen has become mandatory or new field has been introduced.

3. **Repair screen components** – The screen component needs to be repaired (re-inspected) from the Change Analyzer module of SAP TAO

4. **Repair the test cases** – Now the test case need to be modified to handle the input found in the step 2. Suitable parameter value should be provided for the field in the identified test case. The test engineer can also easily jump to the affected test cases in SAP Quality Center by clicking on them in SAP TAO change analyzer module.

**Note:**
To accurately, identify the screen component needed for feeding this new value, the test engineer may need to check the technical information of the screen in the transaction. This way, he could accurately identify the screen number. If the equivalent component for the screen number is not present in the BPT module of SAP Quality Center, it is should be generated by SAP TAO Inspection functionality.

5. **Consolidate the test cases** – The test cases which were modified, needs to be consolidated, so that all the higher level test case can get the fixed component. This consolidation can be triggered from Change Analyzer module itself by clicking on repair component after selecting the consolidated component which is required to be updated.

6. **Execute the repaired test case** – The repaired test case need to be executed once to check the fix done to handle this new input. The execution can be done by adding the test case to Run List from Change Analyzer module itself.

7 **Example for Test Case Repair**

7.1 **Repair using BPCA Integration**

7.1.1 **Customizing Change - PO Number has become mandatory in VA01 transaction**

The standard VA01 transaction is modified via IMG configuration to make PO number a mandatory field.

1. **Identify impacted test cases** – The impacted test cases are identified by feeding in BPCA result ID in the Change Analyzer module of SAP TAO. The suitable BPCA result ID is searched by giving suitable project name.
2. Execute the test cases – The test case is executed from SAP TAO’s Run and Report module. The test case can be easily added to “Run List” by selecting it and clicking on “Add to Run List” button.
3. **Repair the test cases** – To accurately identify the screen component needed for feeding this new value, the test engineer checks the technical information of the PO number of the VA01 transaction. The screen component is already present in BPT module of SAP Quality Center. He drags and drops the component at suitable location and provides the required parameter value.
4. **Consolidate the test cases** - The Create Sales Order consolidated component is repaired from the Change Analyzer module itself.

He also provides the suitable parameter value.
The repair of the consolidated component also provides suitable name for the new column in the data excel.

5. **Provide input data in data excel** – The test engineer provides the suitable data in the data excel of the Create Sales Order test case.
6. **Execute the repaired test case** - The test case is executed again from SAP TAO, and this time the test case passes.

7.1.2 **Custom code change – New input field is introduced in Custom VA01 transaction**

A custom VA01 transaction is created for the purpose of showing the repair using SAP TAO Change Analyzer module. This new sales order creation transaction is one step process, and creates an order just by entering few mandatory fields.

Now, a transport has been done, and we are using BPCA and SAP TAO to identify the impacted test cases and subsequently repair them.

1. **Identify impacted test cases** – The impacted test cases can be easily identified by feeding in the BPCA result Id. The result ID can is searched on the basis of a SAP Solution Manager project.
2. **Execute the test cases** - The test case is show as impacted test case in the Change Analyzer module. The test case is added to Run List for execution.

3. **Repair screen components** - The screen component is repaired (re-inspected) from SAP TAO itself.
5. **Repair the test cases** – The test case is repaired by just providing parameter value for this new field.

6. **Consolidate the test cases** – The consolidated component is repaired from the Change Analyzer module of SAP TAO.

7. **Provide test data in the data excel file**
8. **Execute the repaired test case** – The test case is executed again from SAP TAO’s Run and Report module, and this time it passes.

### 7.2 Repair without BPCA Integration

#### 7.2.1 Customizing Change - PO Number has become mandatory in VA01 transaction

The following steps explain the repair process:

1. **Identify impacted test cases** – The impacted test cases can be identified in the following ways:
   a. Discussing the impact with introducer of the change
b. Going through the transport
c. Executing the relevant automated test cases

2. Execute impacted test cases to **know if it fails** and where
   a. Execution can be done from SAP TAO Run and Report module.

b. The SAP TAO report can point the error and screenshot captured by SAP TAO log can show more details.
### Step Details

<table>
<thead>
<tr>
<th>Execution Time</th>
<th>Step Result</th>
<th>Step Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/06/2011 4:08:36 PM</td>
<td>INFO</td>
<td>Target: Screen</td>
</tr>
<tr>
<td>08/06/2011 4:08:36 PM</td>
<td>INFO</td>
<td>Control: Enter - Key Pressed: 0</td>
</tr>
<tr>
<td>08/06/2011 4:08:36 PM</td>
<td>INFO</td>
<td>Distribution Channel - (Text = 10)</td>
</tr>
<tr>
<td>08/06/2011 4:08:36 PM</td>
<td>INFO</td>
<td>Sales Organization - (Text = 1000)</td>
</tr>
<tr>
<td>08/06/2011 4:08:36 PM</td>
<td>INFO</td>
<td>Division - (Text = 00)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Execution Time</th>
<th>Step Result</th>
<th>Step Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/06/2011 4:08:40 PM</td>
<td>INFO</td>
<td>Shp-to party - (Text = 1000)</td>
</tr>
<tr>
<td>08/06/2011 4:08:40 PM</td>
<td>INFO</td>
<td>Sold-to party - (Text = 1000)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Execution Time</th>
<th>Step Result</th>
<th>Step Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/06/2011 4:08:41 PM</td>
<td>INFO</td>
<td>Target: PO Number</td>
</tr>
<tr>
<td>08/06/2011 4:08:41 PM</td>
<td>INFO</td>
<td>Tablecell_Order Quantity(0) - (Text = 1)</td>
</tr>
<tr>
<td>08/06/2011 4:08:41 PM</td>
<td>INFO</td>
<td>Tablecell_Material(0) - (Text = p - 100)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Execution Time</th>
<th>Step Result</th>
<th>Step Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/06/2011 4:08:43 PM</td>
<td>INFO</td>
<td>Target: Save (Ch+S)</td>
</tr>
</tbody>
</table>

08/06/2011 4:08:45 PM **FAILED** Target: Statusbar - (Text) is set to: Process incompletion log before saving
4. **Repair the test cases** – To accurately identify the screen component needed for feeding this new value, the test engineer checks the technical information of the PO number of the VA01 transaction. The screen component is already present in BPT module of SAP Quality Center. He drags and drops the component at suitable location and provides the required parameter value.

![Diagram showing screen components and parameter values]

He also provides the suitable parameter value.

5. **Consolidate the test cases** – Consolidation is done to incorporate the changes done to the test case so that all the higher level test case benefit out of the change. All the higher level test cases are automatically added to the consolidation.

![Diagram showing test consolidation process]

**Test Consolidation**

Select a test to be consolidated

- All Tests
- Invalid Tests
- All Components

Select tests to consolidate, from the tree below:

- Subject
  - BPT Resources
  - Consolidated
    - Test_Create Quotation
    - Test_Create Sales Order
    - Test_Create Sales Order with Quotation
  - Design
    - Create Quotation
    - Create Sales Order
The repair of the consolidated component also provides suitable name for the new column in the data excel.
8. **Provide input data in data excel** – The test engineer provides the suitable data in the data excel of the Create Sales Order test case.

9. **Execute the repaired test case** – The test case is executed again from SAP TAO, and this time the test case passes.

### 7.2.2 Custom code change – New input field is introduced in Custom VA01 transaction

The following section explains how to repair a change introduced in a custom sales order creation transaction. The details regarding transaction are provided in the section “Repairing with BPCA Integration”.

© 2011 SAP AG
1. **Identify impacted test cases** – The impacted test cases can be identified in the following ways:
   a. Discussing the impact with introducer of the change
   b. Going through the transport
   c. Executing the relevant automated test cases
2. **Execute impacted test cases to know if it fails and where** – The affected test case can be executed from SAP TAO itself. Execution can happen from Run and Report module.

   ![Test List](image)

   The SAP TAO logs can provide details about reason of failure, which is new mandatory field in the screen.

   ![Execution Logs](image)

3. **Repair screen components** - The screen component is repaired (re-inspected) from SAP TAO.
7. **Repair the test cases** – The test case is repaired by just providing parameter value for this new field.

8. **Consolidate the test cases** – The consolidated component should be re-generated from SAP TAO consolidation module. All the higher level test cases are automatically added to consolidation list. Consolidation also add extra column to the data excel.
Test Consolidation
Select a test to be consolidated

Select tests to consolidate, from the tree below:

- Subject
  - BPT Resources
  - Consolidated
  - Design
    - Create Quotation
    - Create Sales Order
    - Create Sales Order from Quotation
    - Cust_Creates Sales Order
    - Display Sales Order
    - O2C
    - O2C with Cust_VA01
    - O2C with Quotation

Test Consolidation
Select a test to be consolidated

<table>
<thead>
<tr>
<th>All Tests</th>
<th>Invalid Tests</th>
<th>All Components</th>
<th>Consolidation List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Tests</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SAP TAO
The following columns were not in the data table. Do you want to add them?

DT_ORDER_REASON
9. Provide test data in the data excel file

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT_CUST</td>
<td>DT_CUST</td>
<td>DT_CUST</td>
<td>DT_CUST</td>
<td>DT_CUST</td>
<td>DT_CUST</td>
<td>DT_ORDER_REASON</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>10</td>
<td>00</td>
<td>1000</td>
<td>P-100</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10. Execute the repaired test case – The test case is executed again from SAP TAO’s Run and Report module, and this time it passes.

8 FAQ

8.1 TBOM Creation

1. Why can’t I establish an association when the system entry in the SAP Logon only contains the IP address of the host?

   SAP TAO uses the configured entry for the Managed System in SAP Logon in order to enable Solution Manager to start/stop/evaluate traces on the Managed System. As the 3 character SID given in the SAP Logon does not allow to determine the Managed System, additionally the message server host must be given. Resolving the message server host from the IP address is not possible; therefore you need to provide the message server hostname.

2. Although I successfully established an association, the execution of the test for TBOM creation does not work. Why?

   There are several possible reasons, in general establishing an association has fewer restrictions than test execution for TBOM creation:
   a. SAP TAO allows you for example to establish an association although you are not connected to any managed system. But, for executing the test you need to be connected to the Managed System.
   b. SAP TAO verifies at association point in time that the managed target system of a test is part of the logical component in the blueprint executable, but it needs not to be the chosen one. At execution point in time you need to have chosen the valid product system of the logical component, therefore it might be necessary to modify the ‘System Role’ in order to point to the appropriate product system. Please note that the ‘System Role’ is user-specific, therefore you need to logon with the same userId to your Solution Manager than used in SAP TAO in order to adjust the ‘System Role’ appropriately.
   c. The userIds used in SAP TAO for both the Solution Manager system connection and the Managed System Connection must be identical due to usage of trusted RFC connections
   d. The userIds registered in the “LaunchAndLogin” component of the Quality Center test must match the userIds SAP TAO used on the Managed System in order to appropriately record and evaluate traces.

3. Although the execution for TBOM creation went fine, no TBOM was created in the executable item of the Project?

   a. For evaluation of the recorded traces on the managed system, trusted RFC connections must have been configured: A connection from your Solution Manager
System towards the Managed System, and also a back connection from the Managed System to Solution Manager.

b. In case a TBOM already existed for the executable item when you started TBOM creation within SAP TAO, then it might be that a subordinate TBOM was created but you don’t see it. Those subordinate TBOMs are only visible when you have set a user parameter on your Solution Manager System (AGS_BPCA_TBOM_CHILD_X, http://help.sap.com/saphelp_em70/helpdata/en/6a/334954d76e498da73d44a7951372f4c/frameset.htm)

4. Do I need to have same user for TBOM creation in SAP Solution Manager and Managed system if there is trusted connection between them?

Yes, same user which is used to connect to SAP Solution Manager from SAP TAO should also be present in the Managed system.

8.2 Miscellaneous

1. Why some SAP GUI sessions are closed when I execute SAP TAO based test cases?

SAP TAO closes all the SAP GUI session before executing any test case. Only those sessions are closed, where scripting is enabled on the server.

9 Appendix

9.1 Manual Test Case Composition

Please note this approach can be followed if the intention is to create one data excel and use for parameter passing as well.

Test composition can be done in SAP Quality Center Test Plan module by dragging and dropping the required components. Test composition would be best explained if we can consider the following example.

Order to Cash Scenario for a rush order could consist of following process steps:

1. Create Sales Order (VA01)
2. Picking (VL02N)
3. Post Goods Issue (VL02N)
4. Create Sales Invoice (VF01)

Following steps should be performed for creation of Order to Cash Test Case using PFA:

1. Perform PFA Analysis for Create Sales Order (VA01).
2. Upload the analysis to SAP Quality Center.
3. Remove “initialize context” and “launch and logon” from the test
4. Consolidate the ‘create sales order’ test case to create a component.
5. Repeat the above steps for picking, post goods issue and create sales invoice.
6. Create a test order to cash manually.
7. Add “Initialize context” and “launch and logon”.
8. Add the transaction of order to cash.
9. Create a spreadsheet where order to cash data is entered, and provide this path in the initialize context.
10. Consolidate order to cash, and create a test case with this component.

9.2 Enable Scripting

It is possible to verify the activation of SAP GUI scripting in the right lower corner of a Sap Gui window:

1. Scripting disabled on the server:

2. Scripting enabled:

3. Scripting enabled and running:

The activation is required on a client machine. To activate scripting follow the step: “Customize local Layout (F12) -> Options -> Scripting -> Enable Scripting.

In cluster environment all cluster systems have to have scripting enabled. For that, process the following:

1. Go to Transaction Code RZ11 on one system of the cluster.
2. Set Parameter Name to “sapgui/user_scripting”.
3. Click Change Value Push Button.
4. Set the Current Value to “TRUE”.
5. Select the Check Box “Same on all servers”
9.3  SAP Logon entries for TBOM Creation

The entries in your SAP logon used for TBOM creation must have a message server configured as the key for uniquely identify the concerned ABAP product system is composed by the short SID and the message server.

So the following entry does **NOT** allow TBOM creation:

![SAP Logon entries for TBOM Creation](image)

**How to create new / rectify existing entries**

1. Backup the existing entry
   a. open the entry in modification mode
   b. copy the name string of the “Description” field
   c. rename it in order to keep it for other purposes
   d. press “ok” to confirm the modification
e. verify in the sap logon that your change has been applied

2. Create a new entry with the same name as the original entry you used for the test case creation:
   
   a. Enter the SID of the desired system and select the proposed entry and click on "next"

   b. change the message server string to the appropriate entry and select one of the entries proposed in the lower part (shouldn’t matter for TAO use-case which one you take)

   c. Press next
d. Paste the formerly copied system string into the description field

![Create New System Entry](image1)

```
Connection Type: Group/Server Selection

System Connection Parameters:
- Description: [Comma-separated list of entries]
- System ID: [Comma-separated list of entries]
- Message Server: [Comma-separated list of entries]
- SAP system: [Comma-separated list of entries]
- Group/Server: [Comma-separated list of entries]
- Instance Number:

Use this page as the last page for next entry creations. This is effective immediately.
```

![Next Steps](image2)

e. Go via next until to the actual creation, accepting the proposed default values on the subsequent screens.

### 9.4 Citrix and SAP TAO

Customers may have Citrix based server landscape for testing purpose. The Citrix software installation on a server enables it to be accessible over web. Multiple users can access the server via a web URL. The benefits for having a Citrix supported system landscape are:

- Customer can have a central Citrix server with all the softwares installed on it e.g. SAP TAO, SAP Quality Center Client, HP QTP, etc
- The central Citrix server may also provide testing efficiency, if its located near to the test systems.
- Customers with geographically distributed test team may consider this approach.

![Citrix and Softwares](image3)

*A central Citrix server with all the testing tools installed, e.g. QTP, QC Client, SAP TAO, etc. The server also has Citrix software installed to make it remotely accessible via web URL.*
SAP TAO has been tested on following citrix servers:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Citrix Version</th>
<th>Architecture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008</td>
<td>Citrix 5.0</td>
<td>64</td>
</tr>
<tr>
<td>Windows Server 2003 Enterprise Edition</td>
<td>Citrix 4.5</td>
<td>32</td>
</tr>
</tbody>
</table>

9.5 SAP TAO and ALM 11 (SAP Quality Center 11)

Please refer to the following note for the details – “1551914 - SAP TAO 2.0. Release Information SP05”.

The execution of tests residing in ALM 11 might through an error. The error could be removed by doing certain special settings which depend on the operating system on which SAP TAO front end is installed.

The following shows all customizations depending on the version of Windows in order to be able to execute a test from SAP TAO:

<table>
<thead>
<tr>
<th>Windows XP</th>
<th>You have to log on as administrator to be able to execute test cases from SAP TAO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista (32 Bit) / Windows 7 (32bit)</td>
<td>Log to the desktop/laptop as administrator and start SAP TAO in admin mode.</td>
</tr>
<tr>
<td>Windows Vista (64 Bit) / Windows 7 (64 Bit)</td>
<td>First logon to the system as administrator to be able to do the below mentioned change.</td>
</tr>
</tbody>
</table>
You have to turn off the Data Execution Prevention (DEP) functionality.
To do so, check the DEP status with the following command in a command prompt:
```
wmic OS Get DataExecutionPrevention_SupportPolicy
```
If the status is all but '0' then run a command prompt as administrator, disable the DEP with the following command and restart the machine:
```
Bcdedit.exe /set {current} nx AlwaysOff
```

Although the environment is customized, sometimes, the BP_EXEC_AGENT and QTP are frozen at the end of an execution. The same behavior is noted when you stop an execution in progress.

### 9.6 Component for Support Messages

For issues faced in SAP TAO, open support message for the component **SV-SMG-TAO**.

### 9.7 Relevant Notes

<table>
<thead>
<tr>
<th>Note No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1404715</td>
<td>SAP TAO 2 Installation Information</td>
</tr>
<tr>
<td>1551914</td>
<td>SAP TAO 2.0. Release Information SP05</td>
</tr>
<tr>
<td>1378813</td>
<td>List of Limitations of SAP TAO Release 2.0.0.0</td>
</tr>
<tr>
<td>1383243</td>
<td>TAO: Migration from SAP TAO 1.0.3 to 1.0.10 and Higher</td>
</tr>
<tr>
<td>1390205</td>
<td>TAO 2.0: TAO Agent patch for PFA</td>
</tr>
<tr>
<td>1391728</td>
<td>SAP TAO 2.0. Release and Upgrade Information</td>
</tr>
<tr>
<td>1368112</td>
<td>Installing ST-TAO 200 on SAP Solution Manager 7.0 EHP1</td>
</tr>
<tr>
<td>1228898</td>
<td>Installation/delta upgrade of ST-PI 2008_1</td>
</tr>
<tr>
<td>1329891</td>
<td>Upgrade for Quality Center to latest patch</td>
</tr>
</tbody>
</table>

### 9.8 For More Information